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Introduction 

 
Welcome to the user guide for the DME client version 4.1.5 for Apple 

iOS. 

The guide is divided into three parts: 

1. An introduction to DME - about the company Excitor A/S and 

what the DME system does. 

2. A description of various general concepts of the DME client. 

3. A description of each feature and function in the DME client. 

Administrators: For information about rolling out the DME 

client to many users, and detailed information about installing the 

client on all platforms, please see the Provisioning part of the 

DME Server Reference. 

Please note that this version of the DME client is compatible with 

both 3.5 and 3.6/4.x DME servers. Some features described in this 

manual only apply to DME 3.6/4.x servers. The main areas of 

functionality supported by 3.6/4.x and not 3.5 are the following: 

 RSS feeds 

 Notes/Journals synchronization 

 Out of Office rules 

 Enhanced e-mail status (icons for replied to, forwarded, and 

follow-up flags) 

 DME AppBox (4.x) 

Whenever there is a difference, this will be indicated in the manual. If 

you are missing a feature in the client that is described in this manual, 

it may be because your DME server does not support it. 
 

Copyright information 

Copyright © 2007-13 Excitor A/S. 

All rights reserved. 

Due to continued product development, this information may change 

without notice. The information and intellectual property contained 

herein is confidential between Excitor A/S and the client, and remains 

the exclusive property of Excitor A/S.  
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If you find any problems in the documentation, please report them to 

us through our customer support services. Excitor A/S does not 

warrant that this document is error-free. Furthermore, Excitor A/S 

does not warrant that the illustrations and screenshots used in this 

document reflect your version or the latest version of the program 

described. For the latest version of this product documentation, go to 

the DME Resource Center http://resources.excitor.com. 

No part of this publication may be reproduced, stored in a retrieval 

system, or transmitted in any form or by any means, electronic, 

mechanical, photocopying, recording or otherwise without the prior 

written permission of Excitor A/S. 

DME, DME Sync, and AdaptivePush are trademarks of Excitor A/S. 

Microsoft SQL Server, Microsoft Exchange, Windows, Windows 

Server 2003, Windows Server 2008, and Active Directory are 

trademarks or registered trademarks of the Microsoft Corporation in 

the United States and other countries. 

Lotus Notes® and Domino® are trademarks or registered 

trademarks of IBM Corporation, registered in the U.S. and other 

countries. 

Apple, Apple iPhone, iPod touch, and iPad are trademarks or 

registered trademarks of Apple Inc., registered in the U.S. and other 

countries. 

All other trademarks are property of their respective owners. 

DME is in part developed and sold under license from Good 

Technology. For more information about patents, see the Excitor 

website http://www.excitor.com. 
 

Company information 

 
12, Spotorno Allé 

2630 Taastrup 

Denmark 

Phone: +45 70 21 68 00 

E-mail: mail@excitor.com 

Website: Excitor website http://www.excitor.com 
 

http://resources.excitor.com/
http://www.excitor.com/
http://www.excitor.com/
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About DME 

DME (Dynamic Mobile Exchange) offers synchronization of push 

e-mail, PIM information (calendar, contacts, to-dos), and optionally 

files, to mobile devices. It fully integrates mobile device management 

with state-of-the-art security and efficient software deployment. DME 

is a mobile client/server solution that works with mobile phones, 

smartphones and PDAs using Android, Apple iOS, Symbian, Windows 

Mobile, and soon Windows Phone 8*) as operating system. DME is 

developed by Excitor A/S. 

The solution enables large and mid-size enterprises to deliver business 

mobility services to employees and to effectively manage and control 

mobile devices without compromising security. DME is device, 

network and operator independent and offers unparalleled TCO, 

unprecedented data and device security, and a very intuitive interface 

for users and administrators. 

*) Please note that not all server features are supported on all platforms. 

Contact your DME Partner for specific inquiries. 
 

Features and benefits 

 Convenient for the user: Push e-mail, calendar, contacts and to 

dos 

With DME on your mobile phone, smartphone, or PDA, you get 

your most critical and often used office tools in your pocket 

wherever you are, whenever you need it. E-mails appear on your 

phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 

Should your phone get lost or stolen, a new DME client can be 

pushed to a new phone in a few minutes after you purchase a new 

DME supported phone or borrow one from someone else – no 

matter where it happens. 

 Fretless security: Mobile security policy enforcement 

E-mails are encrypted over the air and on the device itself using 

full encryption (AES 128-bit or stronger). Shell protection of the 

entire phone, requiring domain password to access all features 

except picking up calls, gives you further security options. 

 Freedom and ease-of-use: Effective control of all devices 

Gain a complete overview of your devices – regardless of make, 

model, or platform. Information about the device model, versions 

and programs installed on the device is listed in the web-based 

DME control center for easy administration. Features, settings and 

available applications and network connections are all controlled 
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centrally and can only be changed by the users to the extent this is 

allowed by centrally applied security policies. Dividing the devices 

into groups makes it easy to change settings/features for many 

devices at a time. 

 Ease-of-use comes in many flavors: Simple support and 

administration 

Push software and upgrades via OMA, Apple MDM, SMS or WAP 

to the users, permit them to serve themselves, or automatically 

upgrade software when the users log on. For support purposes, 

retrieval of device configurations and connection set-up makes it 

possible for you to help users who cannot connect, and a log of 

user actions assists you in identifying the problems and solving 

them. Notification of changes to server status can be sent to the 

DME administrators to ensure they are alerted to problems 

quickly. 

 Freedom of choice: Versatility 

Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 4G, 

3G/UMTS, EDGE...), operator, and on most devices from leading 

manufacturers. Works on Lotus Domino and/or Microsoft 

Exchange collaboration systems. 

Please note that the above applies to the full DME client. Note also 

that due to limitations specific to the some client platforms, a few of 

the features mentioned above are not supported on DME for those 

platforms. Contact you DME partner for specific inquiries. 
 

Terminology 

The following is a list of terms used in this guide, and an explanation 

of the term. 

Term Explanation 

DME Often used for the DME Client. 

DME Server The gateway between the DME client and the 

collaboration system. Also used about the DME Web 

Administration Interface. 

Collaboration system The server-based e-mail and calendar system that your 

company runs - either Lotus Domino (with Lotus Notes 

as the user front-end) or Microsoft Exchange (with 

Microsoft Outlook). 

DME menu The DME menu is the main menu in the DME interface. 

On some devices, you have to select Options to access 
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the menu, on some you select More. 

Select To choose an item or a menu option, whether by 

clicking, tapping, or choosing in a menu. 

In some cases, there is more than one route to selecting an option. 

For instance, on some devices you can create an e-mail either by 

selecting Options > Create > E-mail or by tapping a New e-mail 

icon directly. The manual will usually only mention the regular menu 

route. 
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General concepts 

The following sections contain information that is good to know 

before you begin to use DME. The issues apply to clients of all or 

most platforms, and deal with security, synchronization, and resetting 

the device. 
 

Data security 

DME has a strong focus on security. All e-mails and other DME data 

are securely stored in a secure container on the device - even if the 

SIM card is changed or the battery runs out after you have logged in. 

All data remains encrypted at all times using strong encryption, and is 

only decrypted to memory while it is displayed on screen. 

All communication with the server is encrypted, and the server can be 

set up to require a client certificate, which further prevents attempts 

at unauthorized access from devices that the server does not already 

know. 

It is not possible to export any data from the device to be read 

elsewhere*). Even the clipboard is cleared of any text cut or copied to 

the clipboard when you exit the client - either by just minimizing it or 

by logging out. Note that as of DME Server 4.1 SP1, this security 

feature can be controlled from server. 

All DME-related data on the device (e-mails, calendar items, to-dos, 

contacts, and synchronized files, and other data: SMS messages, data 

on the memory card and internal memory) are deleted in the 

following events: 

 If the SIM card is changed (if set up by the DME administrator). 

See Changing SIM cards for more information. 

 If the user name or password is entered incorrectly a number of 

times (as set up by the DME administrator). 

 If the DME administrator decides to do it. If the device is lost or 

stolen, the data on the DME client can be cleared remotely by 

sending a command from the DME server (remote wipe). You 

should always contact your DME Administrator immediately if you 

lose your device. From DME Server 3.6SP2, you can even log into 

a website and send a wipe command to the device yourself. 

In case a new user logs in, all DME-related data are deleted before the 

Desktop or Inbox is shown. 
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*) Except in some cases where attachments can be printed or sent to 

other devices outside the secure DME container. However, this must 

be explicitly permitted by the administrator. See Attachments on 

page 41. 
 

Changing mailbox passwords 

Depending on your company's security policy, you must change your 

network password at regular intervals. If you use Exchange, your 

network password is the same as your mailbox password, but on 

Domino collaboration systems this is not necessarily so - here you 

use your internet password. The DME client depends on the mailbox 

password to gain access to synchronize your e-mail to the device. 

Your mailbox password can be changed from your desktop computer 

or from your device. If your collaboration system is based on Active 

Directory, a message may pop up telling you well in advance that it is 

time to change your password. If you ignore the warning, your 

current password will eventually become invalid, and you will be 

unable to log on to the system. 

You can either change your password from a desktop computer on 

the network or from the DME client.  

 If your mailbox password is changed from a desktop computer on the 

network, and you have exited DME (for instance in connection with 

a phone reboot) so that your credentials are no longer encrypted 

in memory, then the new password has to be verified on the 

server the first time you log in to the DME client. When you log 

in, and DME recognizes you as a user and recognizes your 

password, but detects that the password has been changed on the 

server, the following message is shown: 

 

You are then asked to enter your new password. 

1. Select Yes to verify the new password on the server. 

2. Enter your old password. 

3. Select Log in, or 
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Select Reset if you want to remove all DME data from the 

device and start over. 

You can now use DME as usual. 

 If your mailbox password is changed from a desktop computer on the 

network, and your device still has your credentials encrypted in 

memory: If you are logged in, DME will log you out the first time 

the device communicates with the server (for instance in 

connection with a network push). When you log in again, you 

should use your new password. DME will assume that you have 

changed password on the server, verify your new password, and 

re-encrypt your credentials without you having to confirm any 

messages. 

 You can change your mailbox password from the client.  

1. Log in to the client as usual. 

2. Open the DME menu, and select Tools > Change password. 

3. Enter your existing password in the Old password field. 

4. Enter a new password in the New password field, and retype 

it in the Confirm new password field. 

5. Select Change. 

 

DME sends the password change request to the server. If the 

server accepts the request, a message tells you that your 

password has been changed. If the server rejects the request, a 

message tells you why the command failed. If the command fails, it 

can be an issue with the server setup, and you should contact your 

DME Administrator. 
 

Switching users 

Unless forbidden by the DME Administrator, you can hand over your 

device to another person, even if it contains all your DME data.  The 

new user cannot view any of your DME data, and all e-mails, calendar 

items, to-do items, contacts, and other synchronized files and 

resources will be erased when the new user logs in to DME. 
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The new user is taken through the same verification process as 

described in Logging in on page 21. 
 

Synchronization overview 

The basic idea of the DME client is to keep the e-mail, calendar 

system, contacts, and other resources on your mobile device 

up-to-date with the corresponding items on the corporate network. 

To do this, the DME client is synchronized with the collaboration 

system or the file server. E-mails, calendar items, contacts and other 

resources are synchronized with the corporate collaboration system. 

On some platforms, you can also synchronize files on the DME server 

or in a network location with your mobile device. File synchronization 

requires a special license - consult your DME administrator for more 

information. 
 

What is synchronized 

In the synchronization (sync for short) process, DME checks the 

following: 

1. Have any items been created? An item could be an e-mail, a 

contact, a calendar item, a to-do, or possibly a file. If an item has 

been created, it is copied to the system on which it does not yet 

exist (for example, if an e-mail was created and sent from the 

mobile device, the e-mail is copied to the Sent folder on the 

collaboration system).  

Furthermore, the e-mail, calendar and other items on the mobile 

device are synchronized with respect to the time span for which 

items should be shown according to the settings. This is called the 

synchronization window. For instance, the settings may specify that 

the e-mail application should show e-mails for the last 7 days. The 

sync process will then clear e-mails older than 7 days from the 

Inbox and other mailboxes except Drafts (on the mobile device 

only). 

2. Have any items been deleted? If an item, for instance a meeting, has 

been deleted in the collaboration system, the deletion will be 

reflected on the mobile device. Note that e-mails deleted on the 

mobile device will not be deleted on the collaboration system, if 

the setting Delete only locally is enabled. Note also that you 

will not receive notification of changes when e-mails are deleted 

from the server. 
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3. Have any items been edited? If you for instance edit a contact on 

the mobile device or on the collaboration system, the change will 

be synchronized. In the same way, if you edit a spreadsheet on the 

mobile device, the sync process will update the spreadsheet on the 

DME server if file sync. is enabled. 
 

Conflicts 

In some cases, a conflict may arise. For instance, if a meeting has been 

moved to another time on both the collaboration system and the 

mobile device, DME will resolve the conflict by moving the meeting to 

the time indicated in the DME client, and a message will be sent to 

you with information about this fact. 

Also, during the initial synchronization of the client or during a 

subsequent reset, duplicate contacts or calendar items may occur. In 

this case, the duplicate entries will be created, and an e-mail listing the 

duplicate entries will be sent to you. 
 

Synchronization methods 

Your device can be synchronized in two ways: 

1. Server-initiated sync (push) 

Whenever someone sends you an e-mail, a meeting invitation, or 

similar, it is received by the collaboration system. The DME server 

will check for such updates in the collaboration system at regular 

intervals and build a queue of messages for your device. The 

server will also generate a command for your device in case 

system settings are updated or a server command is issued.  

Notifications are received through the built-in Apple Push 

Notification Services (APNS) framework on the device. 

2. Manual sync 

If you want to do a manual synchronization, for instance if you 

want to send an e-mail and the Send immediately setting is off 

(see E-mail sync. settings on page 128), you can do so in the 

following ways: 

 From the top of the list in an e-mail folder, drag down and 

release (Twitter-style sync.). 

 From Calendar, Contacts, To-dos, Notes, and RSS Feeds, tap 

the Synchronize button . 

Finally, you can tap the Synchronize button  from the 

Desktop toolbar to synchronize the different item types at the 

same time. For more information about this, see the next section. 
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Synchronization manager 

When you tap Synchronize  from the Desktop, DME shows a 

screen such as the following: 

 
This is the Synchronization manager. The Sync. manager shows 

what resources can be synchronized (e-mail, calendar, etc.), what is in 

the sync. queue, or already running. 

If a resource has never been synchronized before, for instance if you 

have just enabled that resource, DME will automatically import the 

resource using the default setting for initial import: Merge or Wipe. 

For more information, see Initial import and reset on page 16. 
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When you tap Synchronize, the selected resources will be 

synchronized, and resources marked with Import will be imported. 

The Sync. manager shows that a synchronization is in progress, and 

enables you to cancel the synchronization: 

 
The resources available for synchronization depend on your license. 

For instance, if your DME license does not include Calendar sync., 

then that option will not be visible in the Sync. manager. Also, if a 

resource is not enabled in Settings, it is not included here. 

By default, all available resources are selected for synchronization. For 

more information, see Synchronization overview on page 12. 

After the synchronization is finished, the Sync. Manager will disappear 

from view. However, at any time during the synchronization process, 

you can tap the Hide button at the top left corner to continue 

working in the screen from which you chose to synchronize. The 

sync. process is not interrupted if you do this. You may also tap 

Cancel sync. to cancel the synchronization process. 

Note that several windows contain a Synchronize button . If you 

tap that, the Sync. manager will not be shown, but DME will 

immediately start synchronizing the data of the type that is currently 

shown. While synchronizing, the  button changes to a spinner icon, 

and is not available to be tapped. 
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Initial import and reset 

The first time you log in to the DME after installing the client, DME will 

receive a set of default client settings from the server. Based on these 

settings, DME will import data from the server into the enabled data 

stores. For instance, if you have enabled e-mail sync. and calendar 

sync., DME will immediately and silently import your e-mails and 

calendar items from the server. This is called the initial synchronization. 

Your DME administrator has made two important choices which 

affect your initial synchronization: The DME settings for 

Calendar/Contacts mode and Action to perform on client 

upon initial import.  

 If your DME administrator has selected Wipe as initial import 

action, and your calendar and/or contacts are set to Open mode, 

all calendar items and contacts that existed on the device before 

you installed DME are deleted before they are imported from your 

collaboration system mailbox. If you have calendar items and 

contacts that do not exist in your collaboration system also, and 

you want to keep these, you must synchronize them with another 

system first. 

 If the DME administrator selected Merge as initial import action, 

and your calendar and/or contacts are set to Open mode, DME 

will send all your calendar items and contacts to the server. DME 

will then add those calendar items and contacts that do not 

already exist on the collaboration system to your collaboration 

system calendar and address book. DME runs an extensive 

duplicate control to weed out duplicates. This is not too hard to 

do for calendar entries, but requires careful analysis (and thus 

time) for contacts. 

If your calendar and/or contacts are set to Secure mode, DME will 

not touch your local calendar or contacts, regardless of the Action 

to perform on client upon initial import setting. The import or 

reset only affects the stuff that DME is actually handling. 

If you enable the synchronization of another resource after the initial 

synchronization, for instance Contacts, then the initial synchronization 

of this resource will actually be an import.  

This Reset function corresponds to an initial synchronization. If you 

think that any of the resources on your phone are out of sync, you 

can reset the DME data on your phone by choosing Tools > Reset in 

the DME menu. This will perform an import of all resources according 

to the rules outlined above. 
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Note that the DME administrator can also force an import of items 

on your device. In this case, you will not be asked if you want to keep 

the original entries; the device will simply start effecting the command 

and replace from server. 

In the case of contacts in Open mode, you may need to add device 

specific features to the contacts, such as photos, speed dial keys, etc. 

after a reset. These settings will not be lost when you synchronize 

contacts with the server (but they will after a reset). 

See also Flexible field mapping on page 17 below for more 

information about contacts. 
 

Flexible field mapping 

It is possible to create custom mappings between fields in Domino or 

Exchange and contacts on the device. You can use this feature for 

enforcing company policies. 

For instance, you may have a policy of always calling the internal office 

number when calling a colleague in order to cut costs. You can then 

decide to add the internal office number to the "Pager" field in Notes, 

and map the Pager field to the "Telephone (business)" field on all 

devices. 

Custom mapping should be carefully planned, and can only be set up 

in cooperation with a certified DME partner. Partners may request 

special documentation from Excitor A/S. 
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User guide: DME on Apple 

iOS devices 

DME supports Apple devices running at least iOS 4.2. For a list of 

supported devices, see the Supported Devices - Apple 

http://www.excitor.com/Default.aspx?id=47&device_search=Appl

e&device_sortby=product_group website. 

The operation of the DME client for iOS conforms with Apple's 

standards of programming - the graphical user interface functions like 

any other sophisticated iOS application. 

The DME client fully supports both portrait and landscape modes. 
 

Installing DME on iOS devices 

 

DME for Apple iOS devices is installed in the standard Apple way. 

You can either get the client yourself: 

1. Open the Apple App Store in iTunes on your iOS device. Search 

for "dme4" using the search box. 

or 

Go directly to the DME client download page in the App Store by 

typing http://itunes.com/app/dme4 in the Safari browser, or by 

following a link sent to you by your DME Administrator. 

2. Tap the FREE button. The button transforms to an Install 

button. 

3. Tap Install. Enter your iTunes password when prompted, and 

wait for the application download to complete. 

You could also download the DME app using iTunes on your PC or 

Mac, and then synchronize dme4 to your iOS device. 

Or the DME administrator can "push" the client to you: 

1. On the DME server, the DME administrator chooses to "enroll" 

your device into DME using the Apple MDM protocols. 

http://www.excitor.com/Default.aspx?id=47&device_search=Apple&device_sortby=product_group
http://www.excitor.com/Default.aspx?id=47&device_search=Apple&device_sortby=product_group
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2. The DME server sends a link to you, which you must click in order 

to enroll. The link can come by SMS or as an e-mail, and it looks 

something like this: 

 
3. Tap the link to continue. To see the further steps, please see 

Installing DME MDM profile 

http://documentation.excitor.com/server/3_6/index.htm#6206.

htm in the DME server documentation. 

Alternatively, the DME Administrator can distribute a link like the 

following: <DME_Server>/mdm/ (for example 

https://dme.company.com:5011/mdm/). You are then prompted for 

your network (LDAP/AD) credentials. After entering them, you can 

enroll your device with DME by following a two-step process: 

1. Click link one to install the DME Apple MDM Root Certificate on 

your device. 

2. Click link two to receive the DME Apple MDM Enrollment 

Configuration, the installation of which you must then accept. 

DME upgrades are usually handled through the Apple App Store. 
 

http://documentation.excitor.com/server/3_6/index.htm#6206.htm
http://documentation.excitor.com/server/3_6/index.htm#6206.htm
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Starting DME 

First locate the DME 4 icon on the Home screen.  

 
The DME 4 icon shows the total number of unread messages in 

folders in your DME Inbox. You may have other unread messages in 

other mailboxes (for instance POP3/IMAP) in the standard Mail 

application. 

To start DME, tap the DME 4 icon. The first time you launch DME 4 

for Apple iOS, the operating system will ask if you want to allow 

notifications for this program. You should enable this in order to 

receive notifications of new e-mails etc. via the Apple Push 

Notification Services framework. A token will be created for the 

iOS device in question, and the token will be sent to the DME server 

and used to identify the device which is to receive a notification when 

for instance a new e-mail arrives. To turn this feature off (not 

recommended) or adjust the notification settings, tap Settings on 

your device and then Notifications. Tap DME 4, and turn Sounds 

and/or Warnings on or off. 
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Logging in 

When launching DME, you are asked to enter your user name and 

password: 

 
You must log in with the same user name and password that you 

would use for the collaboration system on your desktop computer. 

For Lotus Domino users, this is your "Internet password". Contact 

your IT department if you have problems with your user name or 

password. 

The client remembers the user name from your last login, unless the 

DME administrator has disabled this feature for additional security. 

If you have defined a swipe code (see Setting an unlock pattern on 

page 119), you may log in using that rather than your LDAP/AD 

password (Portrait mode only). If you have defined a swipe code, the 

Login screen will look like this: 
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On iPad, it looks like this: 

 
Move your finger across the tiles as defined when setting the swipe 

code. When you release your finger, the swipe code is evaluated. 

Note that this can only be done in Portrait mode on iPhone and iPod; 

on iPad, you can use swipe in Landscape mode as well. If you rotate 

the device to Landscape mode, you can log in using your regular 

password.  

You have two chances to enter the correct swipe code - if the second 

attempt fails, you are returned to the standard Login screen (see 

above). 

If you accidentally move your finger across tiles that you did not 

intend to touch, you can undo the current swipe by tapping another 

tile with another finger while not releasing the first finger from the 

screen. The screen will flash, indicating that your swipe attempt was 

canceled, and you can try again. 
 

First-time login 

If you are logging in to the client for the first time, the login process is 

different. If you are logging in for the first time, and your device is 

running iOS7, you may be required to supply more information. Please 

see DME and iOS7 on page 24. 
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 Logging in to DME for the first time 

1. DME asks you for the server path. The server path has the form 

dme.yourcompany.com:5011, where dme.yourcompany.com is 

the host name of the server where DME is installed, and :5011 is 

the port number. If you do not know the right host name, ask 

your DME administrator for the server path.  

 

 Host name: Enter the host name in this field, for instance 

dme.yourcompany.com. Do not specify http:// or https://; 

this is added automatically by DME. 

 Secure connection: If this is On (default), DME is run over a 

secure connection (https). If Off, DME runs on standard 

http. This is hardly ever the case. 

 Port number: The port number is by default set to 5011. 

This is the port used for synchronizing data. Only change this if 

your DME administrator tells you to. 

 Test connection: Tap this button to test if you have entered 

the server path correctly. If DME shows a "Connection 

successful" message, you have completed the above fields 

correctly. 

Tap Done to continue. 

2. Back at the Login screen, enter your user name and password as 

described in the previous section, and tap Login. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

24  © 2013 Excitor 

 

3. If the login process is successful (that is, DME can establish a 

connection to the DME server and log in using your user name 

and password), the client will help you complete some setup tasks: 

 
 Tap Set unlock pattern to define a swipe login pattern. See 

Setting an unlock pattern on page 119 for more information. 

 Tap Set private key password if you are running Lotus 

Notes and you use Lotus Notes encryption for your e-mail, or 

if you use S/MIME encrypted e-mail. If you do, you need to 

enter your decryption key in DME; otherwise you will not be 

able to read encrypted e-mail. See Security settings on page 

127 for more information. 

Note that you can complete both tasks later in DME. 

4. When you tap Done, DME will start importing your e-mail and 

other resources from the collaboration system. 

See Initial import and reset on page 16 for more information. 

You are now ready to use DME. 
 

DME and iOS7 

Some organizations will only allow known devices to be created as 

devices in DME. To accomplish this, the DME administrators create a 

list of pre-registered devices and set an option on the DME server that 

tells DME to look at the list for a match before creating the device in 

DME. DME checks the list whenever an as yet unknown device tries 

to connect with DME. 

The DME administrators need a unique identifier for each device - a 

device ID. For some device types this could be the IMEI number. 

However, Apple devices do not disclose their IMEI number. 

Therefore they use the device MAC address (the Wi-Fi Address). This 

works fine with iOS devices up until iOS7, because DME was able to 

retrieve the Wi-Fi Address from the device and present it to the DME 

server as device ID. The DME server could then match that against 

the list of pre-registered devices, and allow it to be created (or reject 

it). 
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However, in iOS7 it is no longer possible to retrieve the Wi-Fi 

Address automatically from the device. Therefore, if the following 

conditions are present: 

 Your device is running iOS7 

 Your DME administrators require that the device is pre-registered 

before allowing it on to the DME server 

 You have never been connected with DME using this device 

(before upgrading to iOS7) 

-then the following message will appear on your device after you have 

entered your network credentials and tapped Login: 

 

When you tap Enter Wi-Fi address, the following screen is shown. 

 

Press the Home button to put DME in the background. Then 

1. Open your device Settings. 

2. Choose General > About. 

3. Scroll till you find the field Wi-Fi Address. 

4. Long-press the field label, until the Copy button appears. 

5. Tap Copy to copy the Wi-Fi Address. 

6. Double-press the Home button, and tap DME to go back to DME. 

7. Double-tap inside the field, and Paste the Wi-Fi Address. 

8. Tap Done. 
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DME will now verify if the Wi-Fi Address you pasted into the field is 

on the list of devices that are permitted access to DME. If successful, 

you are presented with the Login screen again, and you can log in as 

normal. 
 

Removing DME 

 Uninstalling the DME client for iOS 

To remove the DME client application, simply long-press the DME 

application icon on the Home screen. When the icons begin to 

jitter, tap the delete badge on the DME icon, and confirm.  

Note that all data protected by DME will be removed along with the 

application. 
 

The DME Desktop 

The main DME screen is the Desktop. The Desktop gives you quick 

access to the most commonly used features in DME.  

If you are editing an item, DME saves the spot from which you last 

quit DME. If you are for instance editing a calendar entry, and the 

phone rings so you must close DME to take the call, DME will show 

the calendar entry in question when you open DME again, as if you 

never quit DME. 

 

Tap an icon to run the associated function. 
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 A green arrow next to an icon means that changes have been made 

in DME which have not been synchronized with the server yet. 

 If an icon appears dimmed, it means that the initial synchronization 

has not been run for the feature in question. For more 

information, see Initial import and reset on page 16. 

 A badge on the Unread icon shows the number of unread e-mails 

in DME. 

 A badge on the Calendar icon shows the number of meeting 

invitations in the DME Inbox. 

 A badge on the Feeds icon shows the number of unread RSS Feed 

articles. 
 

Desktop actions 

The following is a brief explanation of each Desktop icon, with 

references to more information. Note that the Desktop only shows 

icons for functions that are enabled - for instance, if Contact sync. is 

not enabled, there will be no icon for Contacts. 

 
Go to your E-mail Inbox (see E-mail on page 36). 

 
Go to the Unread folder (see Working with folders on page 30). A 

badge shows the number of unread e-mails in the Inbox. 

 
Open the internal DME Calendar (see Calendar on page 73). A badge 

shows the number of meeting invitations in the Inbox. 

 

Go to the Contacts application (see Contacts on page 94) 

 

Go to the To-do folder (see To-do on page 102) 

 
View the RSS feeds that you subscribe to (see Feeds on page 106). A 

badge shows the number of unread RSS Feed articles. 

 
Open the Domino Notes view (see Notes on page 104) 

 

View attachments that are referenced by e-mails and meetings (see 

Attachments on page 116) 

 

Open the AppBox Launchpad (see DME AppBox on page 107) 
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Rearranging Desktop icons 

You can rearrange the order in which the different icons or shown on 

the Desktop. To do this, long-press the Desktop. The icons start to 

jigger, and you can now drag them to a new place. 

 

Tap Done. The icons are now arranged as you desired. 
 

Notifications 

When a change occurs in the collaboration system, you will receive a 

notification of the fact. For instance, if someone sends you an e-mail, 

the DME server will detect this and try to notify you. This is called a 

push notification, because it is pushed to the device. The push 

mechanism of DME is adaptive, meaning that if one push fails, the 

server will try again using another method. 

1. First the server attempts to notify you using the Apple Push 

Notification Service (APNS) to send the push. When a push is 

sent by the server using APNS, the iPhone (and iPod touch/iPad, if 

connected to a WiFi network) will show a message on top of 

whatever you are doing. The message will display the type of the 

push that you have received - for instance "new e-mail" or "your 

calendar has changed". Apart from the message, two buttons are 

shown: Close (which just dismisses the notification) and Launch 

DME (which launches the DME client for iPhone and initiates a 

synchronization). For more details, see below. 
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The first time you launch DME for Apple iOS, the operating system 

will ask if you want to allow notifications for this program (DME). You 

should allow this in order to receive notifications of new e-mails etc. 

via APNS. A unique token will be created for the Apple device in 

question. This token will be sent to the DME server and used by the 

server to identify the device which is to receive a notification when 

for instance a new e-mail arrives. You can adjust the notification 

settings by tapping Settings on your iOS device and then 

Notifications. Tap DME, and turn Sounds and/or Warnings on or 

off. 

1. If Apple Push is not enabled, the DME server will send a text 

message (an SMS) to the device (iPhone only). The SMS contains a 

link. When you tap the link, DME will launch and initiate a 

synchronization. Note that this requires special setup on the DME 

server. 

Due to limitations in the iPhone operating system, DME is not 

allowed to delete the text message after you have clicked the link. 

In order to avoid running the same DME command twice, you 

should delete the text message yourself. Running the same DME 

command twice does not cause any problems as such, but is an 

unnecessary use of resources. 

Apple Push is controlled by the device operating system. A push 

notification may arrive at any time, and DME's behavior in the event 

of a push depends on the circumstances in which the push is received, 

and on the user's actions. You may receive a notification when: 

1. The screen is active, and you are using another application (not 

DME), and you press Close to dismiss the notification: 

DME never receives the command to open and synchronize. 

2. The screen is active, and you are using another application (not 

DME), and you press Launch DME to dismiss the notification: 

DME receives the command to open and synchronize. 

3. The screen is active, and you are using DME: 

DME receives the command to synchronize - you do not see the 

notification. 

4. The screen is off, and you slide the bottom button to view the 

notification: 

DME receives the command to open and synchronize. 

5. The screen is off, and you ignore the notification. The screen turns 

off again. When you turn on the screen, you will see the 

notification until you slide the bottom button: 

DME never receives the command to open and synchronize. 
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The DME server cannot tell if a client receives a notification or not 

using Apple Push. Therefore, every time you log in to DME, any 

commands from the server that have not yet been executed will be 

sent to the device again. 
 

Working with folders 

The DME mailbox consists of at least the following folders: Inbox, 

Outbox, Drafts, Sent, and Unread. The first four of these folders 

function as the corresponding folders on the collaboration system 

(Notes or Outlook). The Unread folder is a smart folder which shows 

all unread messages in any folder in the DME client. When an e-mail in 

the Unread folder is read, it disappears from view - but naturally 

remains in the folder from which it originated. 

Apart from these standard folders, subfolders created on the 

collaboration system (Notes or Outlook) are also shown on the 

client. However, the content of these folders is only shown if you 

enable the synchronization of e-mails in the folders (see Folder sync. 

settings on page 129). With settings similar to the e-mail settings (see 

E-mail sync. settings on page 128), you can specify how many e-mails 

you want to see in each folder (by age in days) and whether you want 

to synchronize e-mails in folders at all. This is specified as a 

system-wide setting. You can also specify different settings for each 

folder, including whether you want to receive a notification when a 

new e-mail arrives in a folder, as described in the following sections. 
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Navigating the folder tree 

To move between e-mail folders, tap the  icon from a mailbox. 

When you do this, DME shows a list of all folders in the system. Tap 

the desired folder to open the folder in the mailbox view, or tap 

Desktop to go back to the Desktop. 

 

The number of unread e-mails in each folder is shown next to the 

folder name. 

Note also that if a folder is marked with a different color, it means 

that it cannot be selected: 

 

On Domino systems, you can create folders and subfolders at the 

same time by naming a new folder like this: Work\Testing. When 

created in this way, the parent folder (Work) cannot itself contain 

e-mails (but Testing can). Therefore you cannot select the parent 

folder here, but you can select the subfolder. 
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Setting folder options 

In the folders settings (see Folder sync. settings on page 129) you 

can set defaults for the way e-mail folders should be synchronized 

between collaboration system and client. If you have many folders on 

the collaboration system, it is recommended that you set up very 

restrictive default settings for performance reasons, and loosen up on 

individual folders as described below. 

To change synchronization options for a folder, open the folder view 

described above, browse to the folder you want to customize, and tap 

the  icon to the right of the folder name. (Note that you cannot 

modify the settings of the five system folders.) The following screen is 

shown: 

 

 Use default values 

If this setting is On, the current folder uses the general settings 

specified (see Folder sync. settings on page 129). If Apply to 

subfolders is also selected, the default settings will be applied to 

all subfolders below the current folder as well, when you press 

Done. If this setting was Off, and you change it to On, the 

settings in the remaining fields in this screen will be reset to the 

default values when you press Done. 

If you want to apply other settings than the default settings to this 

folder, you must set this field to Off. 

 Sync. folder 

This option can only be changed if Use default values above is 

set to Off. If this setting is On, e-mails in the current folder are 

synchronized with the collaboration system, using the 

synchronization window defined in the field Days back below. To 

avoid too high load on the DME server, you should only 

synchronize those e-mail folders that you really need on the 

device. You can for example consider to not synchronize folders 

containing graphics-intensive newsletters etc. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

33  © 2013 Excitor 

 

 Days back 

This option can only be changed if Use default values above is 

set to Off. When e-mails are synchronized, e-mails from the last 

number of days selected here will be synchronized and available in 

the current folder. 

 Include in mail scan 

This option can only be changed if Use default values above is 

set to Off. If this setting is On, you will receive notification when 

a new e-mail arrives in the current folder. New e-mail can "arrive 

in" subfolders by means of rules, which are set up on the 

collaboration system to automatically distribute new e-mails in 

folders. 

 Apply to subfolders 

If this setting is On, the settings made in other fields in this screen 

are propagated to folders below the current folder when you 

press Done. Use this function with caution, as the setting may 

affect many folders. Note that you can choose this option 

regardless of the value of the field Use default values above. 

Tap Done when you have defined the settings for the current folder. 

Instead of synchronizing e-mail to the client, you can use the Search 

e-mail function to find e-mails in any folder on the collaboration 

system. See Searching for e-mail on page 67 for more information. 
 

DME for iPad 

Excitor does not make a separate DME client for the iPad - all 

supported iOS devices use the same client software. 

This section briefly describes the main differences between DME 

running on iPad and on other supported iOS devices (iPhone and iPod 

Touch). 

 Desktop 

The icons used on the Desktop match the current platform, so 

iPad icons are bigger than on iPhones, and devices with Retina 

display have high-resolution icons. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

34  © 2013 Excitor 

 

 Folders and Inbox 

When you open the Inbox in Landscape mode, iPad shows a 

three-pane view of your mailbox: 

 

Folders are shown to the left, the e-mail list at the top right, 

and an e-mail preview at the bottom right. In E-mail sync. 

settings, you can decide if showing an e-mail in the Preview pane 

should mark the e-mail in question as read - see E-mail sync. 

settings on page 128. 
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In Portrait mode, DME shows you e-mails as a two-pane view with 

e-mails at the top and the Preview pane at the bottom. To go to a 

different folder, tap the Folder icon at the top, and select the 

e-mail folder you want to see: 

 

Meeting invitations received are not displayed in the Preview pane 

on the iPad. Instead, a button with the text Open invitation is 

displayed. 

To read an e-mail in full screen, just double-tap the e-mail in a folder. 

Those are the main differences between DME for iPad and DME for 

other iOS devices. 
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E-mail 

The Inbox contains the e-mails and meeting invitations that have been 

synchronized to DME from the DME server. You access the Inbox 

from the Desktop: 

 

-or from the Folder list (see Working with folders on page 30). The 

description below applies to all mailbox folders in the system, not just 

the Inbox.  

The number of unread e-mails in the current folder is listed in 

parentheses at the top after the mailbox name. 

 

See DME for iPad on page 33 for details about how DME uses the 

larger iPad screen. 

The received time of the e-mails is shown as a time of day when 

received today, and as a day in the week for e-mails received during 

the past week. E-mails received before that show with the full 

received date. 

On the left side of of each e-mail in the mailbox view, one or more 

icons are displayed. The icons tell you quite a bit about the e-mail at a 

glance: 

 An unread e-mail is shown with an orange dot. When the e-mail 

has been read, the dot is removed. 

The e-mail has been replied to. 

The e-mail has been forwarded. 
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 The e-mail has been flagged. 

 This icon after the Sender name indicates that the e-mail or 

meeting invitation contains one or more attachments. 

 This e-mail is a meeting invitation. See Responding to meeting 

invitations on page 84 for more information about meeting 

invitations. 

! An exclamation mark and the subject in a red color indicates that 

the message was sent with high importance. 

Drag up/down, or flick to see more e-mails. 

If you rotate the device sideways, the mailbox view is shown in 

landscape orientation: 

 
You can rotate all screens in DME in this way. On iPad, DME uses the 

larger screen to show the e-mails in a three-pane view. See DME for 

iPad on page 33 for details. 

When you scroll down through a list, such as your e-mail list, you can 

always tap the top-center clock to return to the top of the list. 

For information about searching for e-mail and other items, see 

Searching on page 67. 
 

Checking e-mail 

To check for new e-mail, drag down and then release to synchronize 

the mailbox (Twitter-style sync.): 

 

For more information, see Synchronization manager on page 14. 
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Note that you do not have to synchronize manually, as e-mails, 

meeting invitations, and commands are pushed to the device instantly 

from the DME server using Apple Push. However, you can still 

perform a manual sync. 
 

Reading e-mails 

Tap an e-mail to open it (iPad: double-tap to open the e-mail in full 

screen). The top part of the screen is reserved for information about 

the e-mail and the title. By default, only the sender is visible (and 

Sent by if the e-mail was for instance sent by a proxy). To see any 

other recipients of the e-mail, tap the Details link. 

Pinch together and apart to change zoom level (making the text 

smaller or larger). Double-tap to go back to default zoom level 

(100%). On iPad, you cannot change the zoom level. 

Tap  to see the next e-mail, or  to see the previous e-mail 

in the current folder. 

On iPad, just tap the next e-mail in the current folder. 

If you want to mark the e-mail you are reading as unread, tap the 

Mark unread link next to the received date. 

 

To return to the mailbox view, tap the top left button with the name 

of the current e-mail folder, for instance . 
 

Links 

E-mails and meeting invitations may contain links such as e-mail 

addresses, phone numbers, and web links. Whenever a link is found, it 

is written in blue and underlined (like links on a web page). Tap a link 

to see your options for the link. 

When you tap a phone number, you can select Add to contacts, 

Call, or Create SMS. 
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 Call lets you dial the number. This naturally only applies to 

iPhone, not iPad touch or iPads with no phone module. 

An note about international calls: If a phone number is preceded 

by + or 00, DME will remove any initial 0 in the first set of 

parentheses from the number before dialing it. Otherwise, it will 

be dialed as it is. For instance: The number (012)-555-23421 will 

be sent to the phone dialer as is. The number +44(012)-555-23421 

will be sent to the dialer as +44(12)-555-23421. This is in 

compliance with international standards. 

 Create SMS lets you create a new text message for the person 

in question. 

 Add to contacts copies the highlighted phone number, and 

opens your Contacts. Here you can choose between the 

following options (shown immediately if you are using an iPod 

touch): 

 Create new Contact creates a new, empty contact, inserting 

the phone number in a phone number slot. You can now edit 

the contact further (see your Apple documentation). 

 Add to Existing Contact lets you browse for an existing 

contact to which you want to add the information. 

When you tap an e-mail address, you can choose between the 

following options: 

 New e-mail - create a new e-mail for the e-mail address in 

question. 

 Add to contacts - gives you the same options as tapping a 

phone number (see above). 

 Call - If the e-mail address is found to belong to one of your 

contacts, a call will be placed to the person in question, if a 

phone number is found for the contact. If several phone 

numbers are listed for the person in question, you will be 

prompted to select which number to use. 

 

When you tap a web address, the link is opened in EITHER: 

1. The secure browser. If the Web AppBox is installed, DME will open 

the link in the secure browser provided by the AppBox. If the 
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AppBox is installed, but the browser is not configured correctly, 

the link cannot open. 

2. SmartLink. If the Web AppBox is not installed, DME will evaluate 

the link to see if it is a SmartLink, and open it as such. See 

SmartLinks on page 40 below. 

3. Safari. If the Web AppBox is not installed, and the link is not a 

SmartLink, it will be opened in the Safari web browser. 

For more information about the Web AppBox, see DME AppBox on 

page 107. 
 

SmartLinks 

SmartLinks are links in the body text of e-mails, which are handled in 

a special way by the DME client and the DME server. SmartLinks may 

for instance link to Word documents, PDF files, or other binary files 

that are only available on, say, the corporate intranet. Such files are 

not usually available from outside the corporate network (without 

using a VPN connection). However, when you select the SmartLink, 

the DME client is able to download the file as if it were an attachment 

in the e-mail. 

The use of SmartLinks requires the DME administrator to set up the 

DME server in such a way that the DME client recognizes certain links 

in the mail body text as special links. As described in the previous 

section, DME automatically highlights web links - that is, links starting 

with http: or https: or www. If any such link contains the text 

defined on the DME server, the link will be treated in a special way - 

instead of opening a browser window, the client will send a request to 

the DME server, which will then prompt the client to log in and 

download the requested file (if it exists). You can say that the server 

acts as a proxy. 

 

(Note that the above screenshot is taken from a Symbian device.) 

Example: the body text of an e-mail contains two links: 

1. http://www.example.com/onepagedown 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

41  © 2013 Excitor 

 

Selecting this link will open the built-in browser and go the 

onepagedown page at www.example.com. This is a normal web 

link. 

2. http://intranet.example.com/doc?id=234 

Provided that http://intranet.example.com has been defined as 

a SmartLink site on the DME server, selecting this link issues a 

request to the DME server to download the document defined by 

the document ID 234. 

The downloaded file is opened by the associated viewer immediately. 

When you close the viewer, the file is deleted from the device. 

Please note that the SmartLink functionality is an add-on to DME, and 

special documentation concerning how to set up this feature is 

available to the administrator. 
 

Attachments 

E-mails and meeting invitations containing attachments have an 

attachment icon - a paper clip - added after the sender name in the 

mailbox list view. Attachments can be opened and read, if the file type 

of the attachment is known by your device. For example, if someone 

sends you a PDF, Microsoft Word, or Microsoft Excel document, you 

can read it on your device. 

 Note that if you run Lotus Domino as your collaboration system, 

graphics that have been embedded into an e-mail may also be shown 

as attachments on the client. 

 Opening an attachment 

1. Open the e-mail containing one or more attachments. 

2. Tap the  icon in the Subject line in the open e-mail. 
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3. A list of the attachments to the e-mail is displayed. The file type of 

the attachment is shown as an icon in the left column, and the 

filename and size are shown after that. 

 
To save transmission time and space on the device, attachments 

are not stored on the device unless you specifically choose to 

download them. When an attachment name is written in gray text, 

it means that it has not been downloaded to your device before. 

When it is downloaded, it is encrypted and stored in the secure 

DME container, and you do not need to download it again. The 

attachment name is then written in bold text. You can choose to 

download all attachments to your device in one operation by 

tapping the Download all button at the top right of the 

Attachments view. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

43  © 2013 Excitor 

 

If there are more attachments than what fit on one screen, you 

can move a slider at the bottom of the view to remove the 

smallest attachments from the view, like this: 

 
4. Tap the Sort button to sort the list of attachments by name or 

size, ascending or descending. 

5. Tap an attachment to view it in the DME document viewer (if you 

have a license for that) or in the internal iOS viewer. 

 
In order to prevent memory overrun crashes caused by decrypting 

large attachments, DME for iOS has a limit of 10 MB per individual 

attachment. 

Attachments never leave the secure, encrypted DME area, except 

in two cases: 

1. If the attachment is a ZIP archive, DME needs to save the ZIP 

to a temporary location in order to be able to unzip it and 

display its contents. It is only stored there very briefly - DME 

removes the temporary file as soon as the archive has been 

read into memory. When the ZIP archive has been opened, 

DME lets you choose which of the compressed files to view. 

2. If attachments are exported out of DME. See Editing and 

printing attachments below. 

Tap the Back button in the top toolbar of the DME Viewer to return 

to the attachments list, or tap the top left Attachments button if 

you do not have access to the DME Viewer. See also DME Viewer 

and Editor on page 53. 
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 Editing and printing attachments 

When you are using DME Viewer and Editor, attachments will always 

be opened securely here, and you cannot export documents to other 

apps (such as iBooks). However, if the setting Allow printing is set 

on the server for your device, you can send the document to an 

AirPrint printer by choosing File > Print in the DME Viewer: 

 

You can choose to print one or more copies of the attachment to an 

AirPrint printer according to the settings made in the iOS Print 

Center. For more information, see the section about Printing in 

DME Viewer and Editor on page 53. 

If you are not using DME viewer and editor, and if the DME 

administrator has set the server security setting Disable Send 

button in attachments view to Off, you will be able to open 

attachments in other apps, and print them. Note the security 

implications of this below. 

1. Tap an attachment to download and view it. 

2. Tap the icon in the top right corner. 
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3. DME asks you if you want to print the attachment or you want to 

open it in another application. DME uses the operating system's 

settings for file association. In the example below, the attachment 

is a PDF archive. 

 
4. If you select an application, DME decrypts the attachment, copies 

it to a location outside the area secured by DME, closes DME, and 

opens the attachment in the selected application. The attachment 

is now no longer protected by DME, and selecting Delete all 

attachments (see below) will not remove this attachment from 

the device. 

5. If you choose Print, you can choose to print one or more copies 

of the attachment to an AirPrint printer according to the settings 

made in the iOS Print Center (requires at least iOS 4.2). 

 Removing all attachments from the device 

You can remove all attachments that have been downloaded to the 

device and stored in the secure DME area in one operation. 

1. From the Desktop, tap Tools. 

2. Tap Delete all attachments. 

Note that this option is only displayed if you have in fact 

downloaded one or more attachments. 

3. Tap Delete to confirm. 

See also Attachments on page 116, which is a view that lets you see 

all attachments referenced by e-mails and other resources in DME. 
 

Moving an e-mail 

You can move an e-mail to another folder. 
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 Moving an e-mail 

1. Open the e-mail you want to move. 

2. Tap the  icon to open the folder selection view (see Navigating 

Navigating the folder tree on page 31).  

3. Tap the folder to which you want to move the current e-mail. 

4. The e-mail is moved, and the mailbox view of the e-mail's original 

folder is shown. 

You can also move one or a number of selected items from the 

mailbox view - see Moving e-mails on page 64. 
 

Deleting an e-mail 

When deleting an e-mail, the e-mail is removed from DME and from 

the collaboration system at the next sync. 

 Deleting an e-mail 

1. Open the e-mail, and tap . 

You can also delete one or many selected items from the mailbox 

view - see Deleting e-mails on page 63. 
 

You can see a summary of information about the e-mail you are 

currently reading. 

 Viewing e-mail details 

1. Open an e-mail. 

2. Tap the Details link. 

All recipients of the current e-mail are shown. 

3. Tap any of the recipients. An E-mail details screen shows you 

information about the current e-mail. 

 
The information consists of the date and time the e-mail was sent, a 

list of recipients of the e-mail (individual recipients and mail groups), 

and details about importance and security (whether the e-mail was 

signed or encrypted). 
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Toggling follow-up flag 

You can set or remove a follow-up flag on your e-mails. E-mails 

marked with a follow-up flag have a special status in the collaboration 

system. In Outlook, for instance, they are automatically listed in your 

Tasks pane. 

 Toggling flag for an e-mail 

1. Open the e-mail, whose flag you want to toggle. 

2. Tap the  icon to set the flag, or 

Tap the  icon to remove the flag. 

The follow-up status is updated in the collaboration system after your 

next synchronization. 

You can also toggle the flag for a number of selected items. See 

Toggling flag for e-mails on page 66 for information about how to 

do this. 
 

Creating and sending e-mails 

 Creating and sending an e-mail 

1. From any folder, tap . 

A New e-mail screen appears. 

2. Enter e-mail details as described in E-mail details on page 48. 

3. Write the e-mail. See Writing text. 

4. Apply any options as described in Selecting message options on 

page 50. 

5. Tap Send in the top right corner. 

The e-mail is now saved in the Outbox. Depending on the e-mail 

sync. settings, the e-mail is sent immediately or queued for the next 

synchronization (see E-mail sync. settings on page 128). When the 

e-mail has been sent, it is moved to the Sent folder. 

DME also accepts mailto:: links in HTML pages if the links are 

preceded with the DME protocol identifier dme://. This lets you 

create internal web pages with special e-mail links that open DME as 

mail provider rather than the default Apple mail. Example of HTML 

snippet that opens the DME e-mail client, complete with a recipient 

and a subject: 

<a href="dme://mailto:name@example.com?Subject=Comment 

from webpage">Send comment</a> 
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E-mail details 

The New e-mail screen contains fields for entering recipients (To, 

Cc, and Bcc fields), a Subject field, and a message body field. 

 
1. As you type the subject, the e-mail title changes from New e-mail 

to the entered subject. 

2. Three small icons float above the virtual keyboard. These icons 

give you easy access to: Enter e-mail details, Add and review 

attachments, and hide the keyboard manually. If you hide the 

keyboard, it will reappear when you tap a field in the new e-mail.  

Tip: Some collaboration systems are able to resolve names of 

known users. This means that you only have to enter the short 

name as the e-mail recipient. For instance, you could just enter 

sad in the Send to field, and the collaboration system would 

resolve (expand) the name to Sabine.Adelhof@excitor.com 

automatically. Ask your DME administrator if this is possible in 

your setup. 
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Entering recipients 

With the cursor placed in the To, Cc, or Bcc field, you can start 

typing the name of a recipient. DME will try to predict who you want 

to enter as a recipient, and shows suggestions in a list below the 

recipient field: 

 
DME builds this list from all the e-mail addresses found in your 

mailbox folders, from participants in meetings where you are a 

participant or chair, and from those of your local contacts that have 

an e-mail address. 

When you start typing, DME will match the typed characters with the 

names and e-mail addresses in the list of addresses. For instance, 

typing a "c" might match the following entries in the list: 

 "Chris Rea <chris.rea@music.com>" 

 "Hooray Carlton <hooray@freude.de>" 

 "Melanie C. <melc@spice.com>" 

As you type more characters, the list will grow shorter. In the 

example above, typing an "a" after the initial "c" will limit the list to 

"Hooray Carlton <hooray@freude.de>" only. 

Flick through the list, and tap to add the contact or e-mail address to 

the recipient field. The list only shows contacts that have an e-mail 

address. To add another contact, type a comma, and then start typing 

the name of the next recipient. 

When a recipient has been entered, it is enclosed in an address 

bubble so it is easy for you to see how many recipients there are: 
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The list is sorted alphabetically. If you cannot find the required 

contact, you can tap the search icon  to perform a search in the 

Global Address Book. DME will transfer the letters you have already 

typed in the name field to the E-mail field of the Global Address 

Search window, and execute the search immediately. Then just tap 

the name to insert a name into the recipient field. Tap the  button 

to see more details about a person in the list. 

 

See also Searching for contacts on page 70. 

 Editing or removing recipients 

If you mistype a recipient, or if you want to remove a recipient from a 

field, you can do the following to edit the address: 

1. Tap the address bubble to expand it. 

2. Touch and hold to bring up the on-screen magnifying glass, then 

drag to position the insertion point. 

 

3. Release the finger. Tap Select to display handles which you can 

move to select the text you need, Select all to select all the text 

in the current field, or Paste (if you have recently copied text). 

You can edit or delete the address using the keyboard.  

These are standard features of the iOS operating system. 
 

Selecting message options 

Tap the Details button  to open the E-mail details screen. 

Here you can set specific e-mail options. You can sign, encrypt, and 

mark the message with low, normal, or high importance. 
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 Setting message options 

1. Tap Details in the e-mail you are creating. 

2. Tap the Importance setting you wish to set for this e-mail - 

Low, Normal, or High. 

3. Tap Encrypt to encrypt the e-mail. 

4. Tap Sign to sign the e-mail. To sign an e-mail, your password (for 

either S/MIME or Lotus Notes encrypted e-mail) must be entered 

in the field Private key password in Settings > Security. If it 

is not entered here, DME will prompt you for the password. You 

will not be able to mark the e-mail as signed unless the password 

is entered. If you have questions about this, ask your DME 

administrator. 

Please note the following about signed and encrypted e-mail:  

 When you send a signed e-mail, and the DME server cannot find 

your private key on the server, an e-mail with a notification of the 

error "The DME Server could not send the signed S/MIME e-mail") 

is sent to you by the DME server. Your e-mail will be sent to the 

recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to 

know the public key of each of the recipients of the e-mail. If the 

public key of one of the recipients is unknown to the server, an 

e-mail with a notification of the error ("Cannot find certificate for 

recipient: xx") is sent to you by the DME server. The e-mail will 

not be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please 

contact your DME administrator. 

Select Done to return to the e-mail. 
 

Saving as draft 

If you have started writing an e-mail, and you want to continue writing 

the e-mail at a later time, you can save the e-mail as a draft. 

 Saving an e-mail as a draft 

1. Close the e-mail by tapping Cancel, and select Save when asked 

if you want to save as draft. 

The e-mail is saved to the Drafts folder, and you are returned to the 

mailbox. When you want to finish the e-mail, you can open it from 

the Drafts folder, edit it, and send it in the usual way. 

Furthermore, if you are interrupted when writing an e-mail, for 

instance if you receive a call, the e-mail is automatically saved as a 

draft. When you open DME again, you are returned to the screen 

from which you were interrupted. 
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Responding to an e-mail 

When responding to an e-mail, you have several options available, 

depending on whether the original e-mail was sent to you alone or to 

multiple recipients, and whether the e-mail contained attachments. 

To see the options, open an e-mail, and tap . The illustration 

below shows the options available from an e-mail with attachments, 

sent to multiple recipients. 

 
 

Replying to e-mails 

 Replying to an e-mail 

1. Open the e-mail, and tap . 

2. Tap Reply or Reply to All. 

3. Type a message, and tap Send. 

For more information about sending e-mails, see Creating and 

sending e-mails on page 47.  

If the e-mail contains attachments, you are asked if you want to 

include these in the new e-mail. See Sending attachments on page 

59 for information about how to work with attachments in e-mail 

replies. 
 

Forwarding e-mails 

 Forwarding an e-mail 

1. Open the e-mail, and tap . 

2. Tap Forward. 

3. Type recipient details and a message, and tap Send. 
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For more information about sending e-mails, see Creating and 

sending e-mails on page 47.  

If the e-mail contains attachments, you are asked if you want to 

include these in the new e-mail. See Sending attachments on page 

59 for information about how to work with attachments in forwarded 

e-mails. 
 

Creating meeting from e-mail 

 Converting e-mail to meeting 

1. Open the e-mail, and tap . 

2. Tap Create meeting. 

A new meeting invitation is created. The sender and all primary 

recipients of the e-mail are inserted as Required participants, 

and any Cc recipients are inserted as Optional participants. 

The e-mail Subject is carried over as title of the new meeting. 

If the e-mail contains attachments, you are asked if you want to 

include these in the new meeting invitation. 

This feature is a useful shortcut to turning an e-mail conversation into 

a request for a face-to-face meeting. 
 

Responding to a meeting invitation 

Meeting invitations are marked with a  in the mailbox view. Such 

e-mails are special, as they represent meeting invitations created in 

the collaboration system. For more information, see Responding to 

meeting invitations on page 84. 
 

Working with attachments 

When you open files that have been received as attachments in 

e-mails or meeting invitations, they are downloaded and stored in the 

secure DME container. See Attachments on page 41 for information 

about how to open attachments. 

If you have a license for the DME document viewer and editor, the 

attachments are opened in the DME viewer. 
 

DME Viewer and Editor 

The DME Viewer and Editor technology is licensed from Picsel Smart 

Office. 
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If enabled on the server for your device, the internal viewer will be 

disabled, and all attachments will be opened in the DME document 

viewer and editor. There are several advantages of this: 

1. The attachments never leave the secure DME container, and you 

can be sure that the documents cannot be leaked by accident. 

2. You can use the DME Viewer and Editor to create new documents 

or edit existing documents before sending them. 

With the DME Viewer and Editor, you can work with documents of 

the following types: 

Type View Edit Create 

Microsoft Office documents 
   

Comma-separated value files 
   

Adobe PDF (edit means: annotate text and 

draw freehand text) 
   

Hangul documents (Korean) 
   

Image files: WMF, EMF, BMP, GIF, JPEG, PNG 
   

When you choose to open an attachment, the DME Viewer and 

Editor is initialized, and the attachment is shown. A toolbar is shown 

along the top: 
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 Back: Return to the list of attachments. 

 File: Search for text in the file (some file types), and optionally 

print the file (see below). 

 More: Lets you manually reflow the document or view the file in 

3D 

 Pages: Lets you browse through all pages in the document using a 

carousel view as below. 

 
You can flip through, pinch and zoom the pages. If the top toolbar 

disappears, simply tap the top part of the screen to bring it back. 

Printing 

To print a document, the server setting Allow printing must be ON 

for your device. 

Open an attachment, and choose File > Print in the DME viewer: 
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A screen like the following appears. 

 

1. Choose your printer. 

2. Choose how many copies you want to print. 

3. If the All pages light is green, you will be printing all pages. 

4. If you only want to print some pages, scroll through the document 

in the preview, and tap the pages you want to print. The green All 

pages light is turned off. To print all pages, tap All pages. 

5. Tap Print to send the selected pages to the printer, or Cancel to 

return to the document view. 
 

Creating and editing documents 

With DME Viewer and Editor it is possible to create new documents 

and edit existing documents. This can be done as part of the process 

of creating a new e-mail or responding to an e-mail. Note: The 

workflow described below pertain not only to e-mails, but to all 

resources where attachments can be added, including meeting 

invitations and notes. 

The following requires that you have a license for DME Viewer and 

Editor, and that the settings Enable DME viewer and editor and 

Enable editing are ON for your device. 

 Creating new documents 

To create a new document using DME Viewer and Editor, do the 

following: 

1. Create an e-mail (see Creating and sending e-mails on page 47 

or Replying to e-mails on page 52). 

2. Tap the  icon in the floating toolbar. 

3. Tap  in the top right of the Attachments screen. 
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4. You can now choose the source of the attachment you want to 

send: 

 

Apart from the picture Library, the Camera, and existing 

Attachments on the device, DME Viewer and Editor enables you 

to create Microsoft Office documents. For information about 

adding existing files, see Sending attachments on page 59. 

5. Pick Word (for example). 

6. You are asked to enter a filename for the new document. 

 

7. Tap Create. 

8. Tap on the page to start typing. 
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9. To format text, select the text (tap a word and drag the handles 

that appear). The bottom toolbar gives access to a number of 

formatting options. 

 
For more information about options in DME Viewer and Editor, 

tap More > Help in the top toolbar. 

10. Tap Back in the top toolbar to return to the Attachments list. 

You are asked to save your changes first. 

You can now send the e-mail with attachments. 

 Editing documents 

You can edit documents that are attached to e-mails that you want to 

reply to or forward to someone. To do so, 

1. Open the e-mail with attachments that you want to respond to. 

2. Choose Forward or Reply, and confirm that you want to include 

attachments. 

3. Tap the  icon in the floating toolbar to see the list of 

attachments. 

4. Tap an attachment to open and edit it in DME Viewer and Editor 

(note that you can also create new documents as described 

above). 

5. Make your edits, and tap Back in the top toolbar. 

You are prompted to save your changes. 

The edited attachment is now included in the e-mail you are replying 

to or forwarding. 

Apart from MS Office files, you can also edit Adobe PDF files by 

adding annotations and free-hand text or drawings. 
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Please note: When you send an e-mail with a newly created or an 

edited document, the document is only stored in the e-mail which 

is sent to the recipient. The attachment will also seem to be 

available from your Sent folder, but you are currently unable to 

open the attachment after sending it. Therefore it is recommended 

that you include yourself in the list of recipients if you need access 

to the document you have created or edited. 

 

Sending attachments 

You can include attachments in e-mails in two different ways: by 

forwarding an e-mail that already contains attachments, or by adding 

attachments from the device to new e-mails (either original e-mails, 

forwarded e-mails, or replies). Furthermore, you can add attachments 

to meeting invitations and notes/journals. 

If you add your own attachments (that is, not via a forwarded e-mail), 

you can choose to create new documents using DME Viewer and 

Editor (see Creating and editing documents on page 56) if you have 

a license for that, or you can add pictures and videos from your 

Photo Albums folder, or you can add an attachment which has been 

downloaded to your device. 

 Sending attachments in original e-mails and replies 

1. Create an e-mail (see Creating and sending e-mails on page 47 

or Replying to e-mails on page 52). 

2. Tap the  icon in the floating toolbar. 

3. Tap  in the top right of the Attachments screen. 

You can now choose the source of the attachment you want to 

send: 
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These are the options available if you do not have a license for 

DME Viewer and Editor (see DME Viewer and Editor on page 

53). 

4. Tap Library to select a Photo Album, and tap to select the 

pictures or videos that you want to add (you can select multiple), 

or  

Tap Camera to attach a new photo/video. Note that if you attach 

images and videos directly using the Camera, they are not stored 

on the device, but saved into the new e-mail as an attachment 

directly. 

When you have selected the attachment(s) you want to use, DME 

offers to change the size of the attachment before you add it: 

 

By reducing the size of the image, you can save transmission time 

and costs. Also, you get around an iOS limitation that disallows 

uploads greater than 10 MB. Pick one: 

Small: The longest side of the image will be 320 pixels. For 

videos, this is Low quality. 

Medium: The longest side of the image will be 640 pixels. For 

videos, this is Normal quality. 

Large: The longest side of the image will be 1280 pixels. For 

videos, this is High quality. 

Original: The image will not be resized, and the video will not be 

re-sampled. 

Cancel: Do not add the attachment. 

Note that if the original image is smaller than either of the sizes 

above, then the size will not be shown - for instance, if the image 

is 800 pixels on the longest side, the Large option will not be 

shown. 
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5. Finally, you can tap Attachments to select from among the 

attachments that have been downloaded to your device (from 

existing e-mails). DME shows the list of existing attachments: 

 

Tap to add the attachment to your e-mail. 

6. After adding attachments, you can tap an attachment to view the 

image or video, and you can swipe right or left to delete it. 

7. Tap the top left e-mail button when you are done to go back to 

the e-mail you are writing. 

 

 Sending attachments in e-mails you are responding to 

1. Forward, or reply to an e-mail (see Forwarding e-mails on page 

52). 

2. You can add attachments in the same way as for original e-mails 

(see above). 

or 

If the original e-mail contained one or more attachments, and you 

chose to include the attachments in the forwarded e-mail, you can 

now manage the attachments. 

3. Tap the  icon in the floating toolbar to see the list of 

attachments that were included from the original e-mail. 

4. You can now swipe right on one or more attachments to remove 

them from the e-mail, add more attachments in the same way as 

for original e-mails (see above), open them, and edit them (see the 

Editing documents section in Creating and editing documents 

on page 56). 
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Attachments in forwarded e-mails need not be downloaded to the 

device before they are sent (unless you want to edit them first). DME 

will pull the attachments from the collaboration system when the mail 

is sent, saving transfer costs. 

 Adding attachments to meeting invitations 

1. Create a meeting invitation (see Booking meetings on page 87). 

2. Add attachments in the same way as for original e-mails (see 

above). 

 Adding attachments to notes/journals 

1. Create a note (see Notes on page 104). 

2. Add attachments in the same way as for original e-mails (see 

above). 

Note that the DME administrator may have blocked for adding new 

attachments from the device to e-mails. Furthermore, restrictions to 

the size of attachments apply. The default maximum size is 16MB, but 

this limit may have been increased or reduced by the DME 

administrator. 
 

Mailbox view actions 

The following sections describe actions that are available from the 

mailbox view, as opposed to actions available from within an individual 

e-mail. 
 

Selecting multiple items 

Some actions can be performed on a single e-mail or several, selected 

e-mails - for instance deletion or marking as read.  
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To select several e-mails in the mailbox view, folder, or list, tap the 

Edit button at the top right of the mailbox view. Doing this adds a 

gray circle  next to each e-mail. You can now tap the e-mail(s) you 

want to select. Selected e-mails are marked with a . 

 
The search bar is removed, and the Edit button is changed to a 

Cancel button. 

Tap Cancel to leave Edit mode. 
 

Deleting e-mails 

When deleting an e-mail from the mailbox view, the e-mail is removed 

from DME and from the collaboration system at the next 

synchronization. 

 Deleting an e-mail from the mailbox view 

1. Swipe right over the e-mail title. 

 

2. Tap Delete to delete the e-mail, or tap anywhere else to cancel. 
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 Deleting multiple e-mails 

1. Select the e-mail or e-mails to be deleted. See Selecting multiple 

items on page 62 for information about how to select multiple 

e-mails. 

2. Tap . 

3. Tap Delete to confirm deletion. 

Note that if you delete a large number of items (more than 20 

e-mails/meeting invitations or more than 10 contacts) at a time, the 

next time the device synchronizes, a message will ask you if you really 

want to delete the items on the server. This is to prevent the 

accidental deletion of many items. 

See Deleting an e-mail on page 46 for information about deleting the 

currently open e-mail. 
 

Moving e-mails 

You can move one or more e-mails to another folder. 

 Moving multiple e-mails 

1. Select the e-mail or e-mails to be moved. See Selecting multiple 

items on page 62 for information about how to select multiple 

e-mails. 

2. Tap the  icon to open the folder selection view (see 

Navigating the folder tree on page 31).  

3. Tap the folder to which you want to move the selected e-mails. 

4. The e-mails are moved, and the mailbox view of the e-mails' 

original folder is shown. 
 

Marking e-mails read or unread 

When you read an e-mail in the DME client, the e-mail will be marked 

as read - that is, the e-mail icon is shown as an open envelope instead 

of a closed envelope. Furthermore, the e-mail will be marked as read 

in the collaboration system the next time you synchronize. You can 

mark an e-mail as unread after reading it, for instance in order to 

remember reading it when you get back to the office, or you can 

mark unread e-mails as read. 
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When you read an e-mail, you can tap the link called Mark unread 

next to the received date to mark the current e-mail as unread (or 

tap Mark read to mark the current e-mail as read). 

 
In a mailbox folder, you can apply the actions described below to a 

number of selected items. See Selecting multiple items on page 62 

for information about how to select multiple items. 

 Marking multiple e-mails read or unread 

1. Select one or more e-mails. 

2. Tap  to mark the e-mail(s) as read, or 

Tap  to mark the e-mail(s) as unread. 
 

Sorting e-mails 

You can sort the e-mails in the mailbox view ascending or descending 

by date, sender name, subject, or flag status. 

 Sorting e-mails 

1. In the mailbox view, tap the sort icon . 

or 

2. From the Desktop, tap Settings > E-mail sync. 

3. Tap Sort order. 
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Whichever way you do it, the following screen is shown: 

 
1. Tap your choice of sort order - ascending or descending by Date, 

Sender, Subject, or according to the e-mail's Flagged status. 

2. Tap Done. 

The default sort order is Date (Descending). The selected sort 

order applies to all folders. 
 

Toggling flag for e-mails 

You can set or remove a follow-up flag on your e-mails. E-mails 

marked with a follow-up flag have a special status in the collaboration 

system. In Outlook, for instance, they are automatically listed in your 

Tasks pane. 

 Toggling flag for multiple e-mails 

1. Select the e-mail or e-mails whose flag you want to toggle. See 

Selecting multiple items on page 62 for information about how 

to select multiple e-mails. 

2. Tap the  icon to set the flag, or 

Tap the  icon to remove the flag. 

The follow-up status is updated in the collaboration system after your 

next synchronization. 
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Searching 

Using DME, you can search for e-mails in your mailbox on your device 

or on the collaboration system, calendar items on your device, or 

contacts in your local address book or on the global address book on 

the collaboration system. 

A search can be initiated from the mailbox view, the Calendar view, 

and Contacts, respectively. 
 

Searching for e-mail 

A Search field is shown at the top of every mailbox. 
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If you start typing in the Search field, DME will filter the displayed 

e-mails to match the text you enter. DME searches in all fields of the 

e-mail. 

 
If you still haven't found the e-mail you were looking for, tap the 

Search on server at the bottom of the filtered e-mail folder. DME 

will then perform the same search in the same mailbox on the 

collaboration system, and return the results: 

 
The results returned from the server only contain information about 

Sender, Date, and Subject. The actual contents of the e-mails are 

downloaded from the server when you tap to open the e-mail. 
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Technical details 

Note that the client shows the results in the order in which they are 

presented by the collaboration system. If your collaboration system is 

based on Lotus Domino, the search results are returned in order of 

relevance. If your collaboration system is based on Microsoft 

Exchange, the search results are returned in chronological order (that 

is, by date). 

The server sets a limit to the number of search results. By default, the 

limit is 100 results. 

Please note that for best performance, your mailbox should be 

indexed. For more information about indexing your mailbox, see the 

documentation for Lotus Notes or Microsoft Outlook. 

Note also that if you select a folder which contains other folders, you 

will get different results depending on your collaboration system: 

 If you use Domino, the search for e-mails will be performed in the 

selected folder only. 

 If you use Exchange, a message will be shown: "Do you wish to 

include subfolders in your search?" If you answer Yes, e-mails in 

the subfolders of the selected folder will be searched as well. 
 

Searching for calendar items 

In a similar way to e-mails, you can search for calendar items. You can 

only search for items that have been synchronized to or created on 

the client. 

To search for calendar items, open the Event list view in the 

Calendar. 
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Type the text you want to find. Tap Search to remove the keyboard. 

 
DME shows a list of the meetings that match your search text. All 

fields in the meetings are used in the search. 

 
 

Searching for contacts 

In Contacts, you can search for contacts stored locally or in the 

Global Address Book on the server. 
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Start typing in the Search field. The list of contacts will shrink as you 

type. Tap the Search button in the virtual keyboard to remove the 

keyboard and show the results, or tap Cancel next to the search 

field to remove the keyboard and show all contacts again. 

 
If the contact you are looking for does not exist on your device, tap 

the Global Address Book button. 

 

Enter the text you want to search for. By default, DME will look in 

the Name field of the collaborations system's address book, but you 

can choose to search in the E-mail, Title, Department, or 

Country fields instead. 
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Tap Search. The results are shown: 

 
The search results are shown in the style determined by the settings 

Sort Order and Display Order in the iOS Settings > Mail, 

Contacts, Calendar. Tap the contact you need: 

 
Tap Copy to local address book to store a copy of this contact in 

your local address book. 
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Tap the e-mail field to create a new e-mail for the contact or book a 

new meeting with the contact. See also Using contacts on page 95. 

 
 

Calendar 

DME contains a complete, built-in calendar, which you can use to get 

an overview of your appointments. Meeting invitations from other 

people are received in the DME Inbox, and are transferred to the 

calendar when you accept them.  

From the calendar, you can create new meetings and invite other 

people to the meetings. You can respond to meetings by accepting, 

declining, delegating or proposing a new time for the meeting. 

Meetings that you create for yourself (personal appointments) are 

saved directly in the Calendar. Meetings with other participants are 

also saved directly in your Calendar, and are sent as invitations to the 

other participants (and resources) at the next calendar 

synchronization. 

You will receive alarms for calendar events, even when DME is closed. 

The DME calendar requires that calendar synchronization is enabled. 

See Calendar sync. settings on page 130. 
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Interaction with the device Calendar 

The primary function of the DME calendar is to keep your business 

calendar synchronized with the calendar on your collaboration system 

(Outlook or Lotus Notes), and keep your business appointments 

stored securely in the DME secure container so that nobody else can 

gain access to them. 

 

DME keeps the data in the DME client (calendar, contacts, etc.) in 

sync with the data on the collaboration system. 

Your iOS device also comes with a calendar application, aptly named 

Calendar. This calendar is used for personal appointments, and 

consists of a local source and possibly one or more third-party sources. 

The calendar can be configured to use third-party sources, such as 

Google Calendar or iCloud, in the device Settings. In your device 

Calendar app, you can choose which calendar or calendars you want 

to see, by tapping the Calendars button. 

Excitor recommends keeping business appointments in the secure 

DME container, and personal appointments in the device Calendar. 

This is called Secure mode. 

However, if you want to be able to view your business appointments 

without having to log in to DME, you may choose to mix the 

calendars, so that events from the DME calendar can also be viewed 

in the device Calendar application. 
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This is called Open mode, and can be selected through an option 

called Copy to local in DME. In this mode, calendar events from 

DME are copied to (not synchronized with) a new calendar in the local 

source of the Calendar app. In the example above, the user is 

synchronizing personal appointments from his Google Calendar with 

the device Calendar (as a third-party source). By copying DME events 

to the local source we make sure that data from DME is not mixed 

into the user's Google calendar (which may also be shared with 

others). 

Note: For this to work correctly with third-party synchronization 

services other than iCloud, you must ensure that a local calendar 

source exists before you enable the third-party sync. If it does not 

exist already, the third-party service will take over the entire 

calendar, and DME will be unable to create a local calendar. You can 

prevent this from happening in one of the following ways: 

1. Make sure the DME calendar mode is Open (Copy to local is 

On) before you enable third-party sync. 

or 

2. Manually create a calendar appointment in the device calendar 

before enabling third-party sync. 

Note: This does not apply if you synchronize with iCloud. If you do that, 

be sure to see Synchronizing calendar with iCloud on page 76. 

In Open mode, there are some considerations: 

 DME-related events and appointments must be created, deleted 

and updated from DME. Any modifications in the local DME 

calendar in the device Calendar app will not be synchronized back 

to DME. It is one way only - from the secure DME calendar to the 

device calendar, meaning that: 

 DME creates the entries in the local DME calendar in the 

device Calendar app. 

 DME updates the entries in the device calendar when they are 

changed in DME. 

 DME deletes the entries in the device calendar when the 

synchronization window changes or when they are otherwise 

removed in DME. 
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 If you decide to change to Secure mode, any events in the local 

DME calendar in the device Calendar app are removed. In fact, the 

entire local DME calendar is removed. Everything is of course still 

securely stored in the DME calendar. 

 Creating local calendars programmatically is not supported on iOS 4.  

This means that on iOS 4, DME cannot create the required local 

calendar, and therefore users of devices that have not yet been 

upgraded to iOS 5 do not have the option to use Open mode. 

 If you are synchronizing your device calendar with iCloud , the Apple 

iOS hides all local calendars in the device calendar, for as yet 

undisclosed reasons. Again, be sure to see Synchronizing 

calendar with iCloud on page 76. 

Using another option in DME, called Show in DME, you can tell the 

secure DME calendar to show all entries from the device Calendar in 

DME. The entries are shown with the colors selected for the entries 

in the device Calendar app. as shown below.  

 
For information about how to switch calendar modes and set the 

Show in DME option, see Calendar sync. settings on page 130. 
 

Synchronizing calendar with iCloud 

Special rules apply when you are synchronizing with iCloud. iCloud 

synchronization does not follow the same rules as other third-party 

synchronization services do, and the following steps are required if 

you want to run the Calendar in Open mode (Copy to local). 

 iCloud: Setting up DME Open mode with iCloud 

1. Make sure that the DME calendar runs in Secure mode (Copy to 

local is Off). 
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2. Enable iCloud calendar sync in your device Settings. 

3. Manually create a calendar, and call it DME. 

4. Set the DME calendar mode to Open (Copy to local is On). 

If you do not perform these steps, you risk having what seems to be 

duplicate calendar entries in your device calendar (and your DME 

calendar, if Show in DME is enabled). 

The reason for this is that when iCloud is enabled, it completely takes 

over any existing local calendar source. This can be illustrated as 

follows. 

The calendar with DME in Open mode, and before iCloud is enabled: 

 

What happens when iCloud is enabled: 

 

So the trick is to manually create a calendar in iCloud called DME. 

With iCloud enabled, the device calendar will only show entries from 

calendars that are controlled by iCloud. However, when you manually 

create a DME calendar in iCloud, iCloud allows the entries stored in 

the similarly named local calendar source by DME to be shown in the 

device calendar also. 

If you are already experiencing duplicate calendar entries in your DME 

calendar in Open mode, you can do the following to fix it: 

 iCloud: Fixing duplicate iCloud calendar entries 

1. In iCloud, delete any DME calendar. One or more prompts will 

warn you that you may lose calendar entries, but confirm the 

deletion anyway - you will only lose the duplicate entries. 

2. In DME, set the DME calendar mode to Secure (Copy to local is 

Off). 
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3. Manually create a calendar called DME in your iCloud-enabled 

device calendar. 

4. Set the DME calendar mode to Open (Copy to local is On). 

Your duplicate entries will be gone. 

If you have set up iCloud and DME correctly, and you temporarily 

disable the iCloud sync, you should do the following. 

 iCloud: Disabling and re-enabling iCloud 

1. In DME, set the DME calendar mode to Secure (Copy to local is 

Off). 

2. Re-enable iCloud. 

3. Set the DME calendar mode to Open (Copy to local is On). 

Since you have already once created the DME calendar manually, 

iCloud will not take over the DME calendar created by DME when 

you enable Open mode, and things are working again. 
 

Calendar views 

To view the calendar entries in the DME calendar, tap  from the 

Desktop. The icon shows today's date. 

You can view your calendar entries in three different views. Along the 

top of each view is a View selector: 

 Tap to see your appointments in different 

views: 

 Month view: See an overview of your schedule for one month. 

This is the default view in portrait mode. Browse to the previous 

or next month by swiping the month calendar or tapping the left 

or right arrows shown around the month name and year. Today's 

date is recessed and shown with a gray background. The week 

numbers are shown along the left-hand edge. Dates shown with 

boldface text contain appointments. Tap a date to show the 

appointments for that day. The currently selected day is shown with 

a blue background. Your appointments for the selected date are 

listed beneath the month view. 

If an event has an alarm, a small alarm icon  is displayed with 

the event. If other people have been invited to the meeting, a 

small participant icon is displayed with the event . 

If you have chosen to also show personal calendar events in DME, 

these events from other calendars in your device Calendar app are 
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shown in the color defined for the personal calendar to which the 

event belongs. See Calendar sync. settings on page 130 and 

Interaction with the device Calendar on page 74. 

Tap  to go to the Day view, or rotate to landscape mode to 

go to the Week view. 

 Day view: See all calendar entries for one day. Browse to the 

previous or next day by swiping, or by tapping the left or right 

arrows shown around the day name and date. The events are 

shown as Subject (Location). 

The events shown are color-coded according to their type: 

 Green: Personal event (no other participants). 

 Blue: Accepted meeting. 

 Red: Tentatively accepted meeting. 

 Gold: All-day event. 

 Gray: If you have chosen to also show personal calendar 

events in DME, these events from other calendars in your 

device Calendar app are shown in gray. See Calendar sync. 

settings on page 130. 

Tap  to go to the Month view, or rotate to landscape mode 

to go to the Week view. 

 Week view: Rotate to landscape mode to go to the Week view. 

Here you see all calendar entries for one week. Browse to the 

previous or next week by swiping, or tapping the left or right 

arrows shown around the month name and year. The week number 

is shown to the far left, above the times. 

Rotate to portrait mode to return to the view that was shown 

before you showed the Week view. 

 Event list view: Tap  to go to the Event list view. This view 

lists all your events in one screen. In this view, you can search for 

a particular event. See Searching for calendar items on page 69. 

A badge on the Event list button means that you have received 

one or more meeting invitations that you have not yet replied to. 

These meeting invitations are shown at the top of the event list: 

 
Tap an invitation to respond to it, or tap an appointment to view 

details or edit it. 
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The calendar shows all the appointments and meetings (collectively 

known as events) from the beginning and till the end of your calendar 

synchronization window (the period within which DME synchronizes 

your calendar - see Calendar sync. settings on page 130). 

Examples of the different calendar views are shown below. 
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Tap the Home icon to return to the Desktop, or the Plus icon to 

create a new meeting. See Booking meetings on page 87. 
 

Calendar actions 

From each view, you can select the following actions: 

 Create meeting: Tap the  button to create a new meeting. 

The default date set for the new meeting is the currently viewed 

day. In the Week view, the date of the new meeting is set to the 

date last viewed in one of the other views, or, if you entered the 

Week view directly, the default date is set to the first day within 

the viewed week. If that date has passed, today's date is suggested 

as the meeting date. See Booking meetings on page 87. 

 Today: To go to today's date in any view, tap the Today button. 

 Synchronize: Perform a manual calendar synchronization by 

tapping the  button. See Synchronization manager on page 

14 for more information. 
 

Viewing and editing meetings 

To view details about a meeting in the calendar, tap to open it. You 

can now see all the fields that have been completed for this meeting, 

but you cannot initially change any fields. 

 
Tap [View name] (August in the illustration above) to return to 

the calendar view. 

If you tap the Participants or Notes field, the field's information 

opens in a separate view, where any included links are active. For 

information about the options in the bottom toolbar, see Responding 

to meeting invitations on page 84. 
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By tapping the New button , you create a new e-mail to all 

participants in the meeting. This can be handy; for instance if you need 

to send a quick message to everyone in the meeting that you will  be 

half an hour late. 

Tap Edit to edit details of the event. Your available options depend 

on whether you organized the meeting in question (you are the chair) 

or you were invited as a participant. 

 Calendar options for the meeting chair (organizer) 

 Change meeting details 

If you are the chair (organizer) of the meeting, you can change any 

of the details of the meeting when you click Edit, including 

removing and adding participants. All fields in the meeting 

invitation are opened, and you can make any change you want. 

 

 Note: The Domino collaboration system permits the use of 

formatted text and attachments in the meeting description. If the 

description (the meeting notes) contains attachments, you will not 

be able to edit the description on the device. If there are no 

attachments, and you edit the Description field on the device, any 

formatting and any embedded objects in the field will be lost when 

the calendar event is synchronized back to the collaboration 

system. 

When you are done, you may select Check free time in the 

DME menu to verify that all participants are free at the time in 

question, if you have changed the meeting time or date 

(corresponding to a Reschedule action). For more information, 

see Checking free time on page 93. 

Select Save in the top toolbar to save your changes. If you 

remove a participant from the list of required participants, the 
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participant receives a meeting cancelation notice, and the meeting 

will be removed from the calendar of that participant. 

If you have rescheduled the meeting (changed the start or end 

time or date of the meeting), you are given an option to add a 

comment to explain the change. 

 Cancel meeting 

If you want to cancel and delete the meeting, tap the meeting to 

open it. 

Tap . You are given the option to add a comment, which will be 

sent to all participants. Tap Cancel meeting to remove the 

meeting from the calendar of all participants and send the 

comment to each participant when you synchronize. 

 Note: If your collaboration system is Exchange 2003, DME is 

unable to process meeting cancelation notices. This means that if 

you receive a notice about a canceled meeting, you must accept 

the cancelation in Outlook or Outlook Web Access (the OWA 

webmail client). 

When you make any changes, DME asks you if you want to 

synchronize the calendar immediately. 

 Calendar options for meeting participants 

If you are a participant in the meeting, and not the chair, the following 

options are available for meetings that have been accepted: 

 Edit: Select this option if you want to change details in the 

meeting. As a participant, you only have access to toggle the 

Private status of the meeting and the Alarm (and possibly set the 

alarm time). After editing these fields, select Save in the DME 

menu to save your changes. 

The toolbar shows three icons used for quick replies: 

 Accept, Tentatively accept, and Decline. You can also 

tap the Reply  button in the toolbar to access the options 

Propose new time and Delegate. For information about these 

options, see the next section, Responding to meeting invitations on 

page 84. Note that selecting Delegate or Decline removes the 

calendar entry from the calendar immediately. 

Tapping  gives you the option to either Delete or Decline the 

meeting. In both cases, the calendar entry is removed - but the 

Decline option also sends a cancelation notice to each participant 

when you synchronize. 

After making any changes, DME asks you if you want to synchronize 

the calendar. 
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Responding to meeting invitations 

When meetings are booked on the collaboration system, all invited 

participants receive a meeting invitation by e-mail, containing 

information about the meeting. 

In the DME client, you can find your meeting invitations in two ways: 

In the Inbox, meeting invitations can be recognized by a meeting icon 

 - see E-mail on page 36 for more information. On the Desktop, 

you can tell that you have new invitations if the Calendar icons shows 

a badge. The calendar List view will list meeting invitations to which 

you have not yet responded (see Calendar views on page 78). 

A meeting invitation is actually an ordinary e-mail, but with added 

options. The standard e-mail options of Reply, Forward, etc. are 

described elsewhere - see Responding to an e-mail on page 52. This 

section describes those options that are specific to meeting 

invitations. 

 Responding to a meeting invitation 

1. Open the meeting invitation. You see an overview of the meeting, 

with subject and time of the meeting, who organized the meeting, 

who have been invited (participants), and any information about 

location and resources involved in the meeting. 

 
DME checks your calendar and immediately shows you if the 

invitation overlaps another meeting in your calendar. If it does, the 

message "Meeting conflicts with your existing schedule" is shown 

in red below the option buttons. Tap the Calendar icon in the 

invitation to open your calendar on the meeting date. 

Tap the location icon to open the meeting location in Maps. 
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2. You can now choose among a number of options. Most of the 

options are available on all supported collaboration systems, but 

there may be differences, which are noted below.  

Furthermore, the description of the actions pertain to the 

standard way of inviting to meetings. For instance, in Domino the 

chair can select options in the meeting invitation in Notes 

specifying that he or she does not want to receive responses from 

invitees (participants), wants to prevent counter-proposals, or 

wants to prevent delegation. Such options are naturally observed 

by DME, even if they are not mentioned in the descriptions below. 

 Accept: Accept the meeting invitation. The meeting is created 

in the calendar, and a notification of your acceptance is sent to 

the meeting organizer/chair. 

 Tentative: If you want to attend the meeting, but you are not 

sure that you are available at the proposed time, you can 

tentatively accept the meeting. This way the meeting is booked 

in your calendar, but the time still appears free for other users. 

Note: On Exchange 2003 systems, this action is not available 

for recurring meetings. 

 Decline: Decline the meeting invitation. Notification of this is 

sent to the organizer/chair and any other participants. 

The following options may be available when you tap the Reply 

 button in the toolbar: 

 Standard e-mail reply options: See Responding to an 

e-mail on page 52. 

 Propose new time: If you would like to attend, but you are 

not available at the proposed time, you can propose a new 

time (also called countering the meeting proposal). Selecting this 

option opens a new screen in which you can select a new time, 

date, and time zone for the meeting. 
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When you are done, select Send to suggest the new proposed 

time to the chair. When you send the new proposed time, the 

meeting chair/organizer will receive an e-mail with the subject 

Countered: and the subject of the meeting. 

Please note that once the calendar entry has been accepted, 

you are not able to change the time zone of the calendar entry 

if you subsequently edit the calendar entry from your calendar 

to propose a new time. Note: On Exchange 2003 systems, this 

action is not available for recurring meetings. 

 Delegate: If you are unable to attend the meeting, you may 

want to send someone else in your stead. Choose Delegate, 

and select another user from your local or global address 

book. 

 

The Delegate field functions as other recipient fields, with the 

ability to choose from the local and global address books and 

addresses from the Inbox. See Entering recipients on page 49 

for more information. 

When you are done, tap Send to send the delegation, or 

Check free time to see if the new proposal conflicts with the 

calendars of any of the required participants. For more 

information, see Checking free time on page 93.  

3. When you accept, decline, tentatively accept, propose a new time, 

or delegate a meeting invitation, you are given the option to add a 

comment. If you enter a comment, it is sent to the organizer/chair. 

Note: On Exchange 2003 systems, not all actions allow you to 

reply with comments. 

4. When you respond to a meeting invitation by using any of the 

above actions, the e-mail containing the invitation is removed from 

your Inbox, and if you accepted the meeting, your calendar is 

updated on the collaboration system at the next calendar 

synchronization. 

Apart from these options, you can use the icons along the bottom of 

the screen to do the following: 
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 Delete the meeting invitation without responding. 

 Move the meeting invitation to another folder. Note: the badge 

indication of new meeting invitations only applies to invitations in 

the main Inbox - if you move the meeting invitation to another 

folder, the badge will go away even if you have not yet responded 

to the meeting. See Moving an e-mail on page 45. 

 Mark the meeting unread/read or Flag it - see Toggling 

follow-up flag on page 47. 
 

Recurring meetings 

Recurring meetings created on the collaboration system are 

synchronized to DME as a series of individual appointments. This 

means that if you edit one in a series of meetings, only that instance 

of the meeting series will be changed. If you want to edit the entire 

series, you must do so in Microsoft Outlook or Lotus Notes. 

Recurring meetings created on the device are sent to the server as a 

true series of recurring meetings, not as individual events. If you 

create a recurring meeting on the device without an end date, the 

DME server will add an end date automatically. The end date will be 

five years in the future. 
 

Booking meetings 

You can book meetings in your corporate calendar from the DME 

client. You can invite people to attend the meeting, and you can 

reserve rooms and resources. This basically works the same way as 

booking meetings in your collaboration system. 
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 Creating a new meeting 

1. To create a new meeting, tap the  button from the Calendar. 

 

2. Enter meeting details: see Entering meeting details on page 88. 

3. Book a room and resources: see Rooms and resources on page 

91. 

4. Add participants: see Adding participants on page 92. 

5. Check to see if the calendars of all participants are free at the 

proposed time: see Checking free time on page 93. 

6. Add any notes (a description) by tapping the Notes field. 

7. Add any attachments to the meeting invitation (see Sending 

attachments on page 59). 

8. To finalize the creation of the meeting, select Send (if you have 

invited participants) or Save (if it is a personal appointment). 

DME will prompt you to synchronize immediately. At the 

synchronization, meeting invitations are sent to the selected 

participants. The meeting is shown in your calendar whether you 

choose to synchronize or not. 

If you tap Cancel during the creation of a meeting, you can choose to 

Save as draft or Discard changes. Selecting Save as draft saves 

the meeting as a draft in the Drafts folder, allowing you to interrupt 

your work on the meeting proposal for a later time. The Discard 

changes option closes the current meeting draft without keeping any 

of your edits. 
 

Entering meeting details 

You can enter or change a number of details about the meeting. 
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 Subject: Enter a subject for the meeting. 

 Location: Here you can enter free text describing the location of 

the meeting - for instance an office, a country or a city.  

 Date and time: Tap the Start or End field, and spin the wheels 

to select the starting and ending date and time for the 

appointment. 

If you set the field All day to On, the appointment changes to an 

all-day event, and you can only choose a date. 

 

 Time zone: In this field you select the time zone of the location 

where the meeting is held. For instance, if you are based in 

Copenhagen, but want to call a meeting at 2 PM in London, you 

should enter 2 PM as the meeting start time, and Europe/London 

in this field. This way, the meeting will be placed correctly in your 

calendar - which is at 3 PM in local Copenhagen time. When you 

travel to London, and the phone changes time zone, it will be 

shown correctly in the calendar at 2 PM, London time. 

Use the search box at the top of the screen to search for your 

time zone. 
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 Repeats: Tap Repeats if you want to define a repeat schedule 

for the current event. You can choose to repeat the current event 

at the intervals listed in the Repeat screen. 

 
Note that when you create recurring (repeating) meetings, you 

will not be able to see the individual instances of the meeting on 

your device until you have synchronized your calendar. This is 

because the individual entries are actually created by the server, 

not the client. See Recurring meetings on page 87. 

When you set a repeat value and tap Done, a new field is shown: 

End repeat: Here you can set a date for the last meeting in the 

series of repeated meetings, or you can choose Repeat forever. 

By default, DME sets a date that corresponds to repeating the 

meeting 5 times. If you choose Repeat forever, the server will 

set an end date 5 years into the future (see also Recurring 

meetings on page 87). 
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 Alarm: Enable or disable the alarm. When the alarm is enabled, 

you can enter a date and time for when the alarm should go off. 

 

 Private: Mark the meeting as private. This means the the meeting 

details are not visible to other people in the collaboration system 

when you sync the calendar item, but your time will appear 

booked. 

 Notes: Enter more information about the new appointment, such 

as an agenda. This will be the body text of the calendar entry. 

 Attachments: Here you can select one or more attachments to 

include in the meeting invitation. See Sending attachments on 

page 59. 
 

Rooms and resources 

To book a corporate meeting room or a resource (such as a 

projector), tap the field Rooms or Resources. The procedure for 

booking a room or a resource is identical - in the following, the 

booking of a room is described. 

The first time you open the Rooms page, it is quite empty. This is 

because you must download the available rooms and resources from 

the collaboration system to your device first. A message asks you if 

you want to do this now: 

 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

92  © 2013 Excitor 

 

 Downloading rooms and resources 

 Confirm the initial prompt to download rooms or resources, or 

tap the  button to retrieve the list of rooms and resources. 

DME asks you to confirm your action. 

You can always refresh the list of resources by tapping the  

button. 

 Selecting rooms and resources 

1. The list of rooms or resources retrieved from the collaboration 

system may contain multiple sites, and you may need to choose a 

site before you can see the list of rooms or resources. If your 

organization only uses one site, the list of rooms or resources is 

shown directly. 

2. Flick up and down in the list of rooms or resources, and tap to 

mark the rooms or resources you want to book. Note that if the 

people capacity of the room is entered in the collaboration 

system, it is also shown in the list. 

 

3. Select Done. 

The selected rooms or resources are entered into the field in 

question, and you are returned to the meeting creation form. 
 

Adding participants 

To add participants to the meeting, do the following: 

1. Tap Required participants. 

2. In the To field, add or select participants as you would for an 

e-mail. See E-mail details on page 48 for more information. 

3. Tap Save to return to the meeting creation form. 
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Repeat this process for Optional participants and FYI participants 

(also known as CC recipients). 
 

Checking free time 

When participants, rooms and resources have been added, you can 

check if they are available within the specified time frame. 

 Checking free time 

1. Tap Check free time in the toolbar. 

After DME has checked on the server, you will see a message 

indicating whether all participants and resources are available or 

unavailable within the selected time frame. 

If one or more participant or resource is unavailable, the following 

options are shown: 

 

2. Tap Available times to show alternative time frames 

or 

Tap Cancel to keep the current time frame. 
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If you choose to show alternatives, you will see a list of time 

frames within which all participants and resources are available. 

The red color marks unavailable time; green marks available time. 

 
3. Flick up or down, and tap to select a new time frame and return 

to the meeting creation form. 

The meeting details are changed to reflect the update. 
 

Contacts 

DME contains a complete, built-in contacts application, which keeps 

your business contacts synchronized with the personal address book 

on your collaboration system (Outlook or Lotus Notes). Contacts 

that are created, deleted, or updated on the device are created, 

deleted, or updated in Outlook/Notes as well, and vice versa. 

Whenever you create an e-mail or book a meeting, you can choose 

recipients from your local contacts or from the Global Address Book 

(your company directory). See Entering recipients on page 49 for 

more information. 

 See Initial import and reset on page 16 for information about 

special considerations in connection with the initial synchronization or 

import of contacts from the collaboration system. 

The DME contacts requires that contact synchronization is enabled. 

See Contacts sync. settings on page 132. 
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Using contacts 

To view your local contacts, tap  on the Desktop. 

The list of contacts in your DME address book is shown. The contacts 

are shown in the style determined by the settings Sort Order and 

Display Order in the iOS Settings > Mail, Contacts, Calendar, 

where you can for instance choose to sort your contacts by Last 

name and then First name, but view them with First name first or Last 

name first. 

 

Flick through the list, or tap the small list of letters to the right to go 

to a certain letter of the alphabet. 

Or start typing in the Search field. The list of contacts will shrink as 

you type. Tap the Search button in the virtual keyboard to remove 

the keyboard and show the results, or tap Cancel next to the search 

field to remove the keyboard and show all contacts again. See also 

Searching for contacts on page 70. 
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When you find the contact you need, tap it. 

 

You can now tap any of the fields to use the information in the field: 

 Tapping a Phone field lets you create an SMS or MMS message to 

the contact, or place a call to the contact. 

 

 Tapping an E-mail field lets you create an e-mail for the contact, or 

book a meeting with the contact. 
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 Tapping a Website field opens the link in an internal web viewer. 

 Tapping an Address field opens the address location in Google 

Maps. 

 

Finally, you can tap the Export button to attach the contact 

information to a new e-mail. The contact will be attached as a vCard, 

and the name used as subject in a new e-mail. 
 

Working with contacts 

Different contact applications on different phones and phone 

platforms support different contact fields. A contact field is for 

instance the First name field or the Telephone field in a contact. 

When synchronizing the address book in MS Outlook or Lotus Notes 

to a mobile device, different third-party applications may map the 

fields in Outlook/Lotus Notes to the phone in different ways. 

The DME Address Book supports a large, but fixed number of fields. 

By using DME for synchronizing contacts, you can be certain that 

everybody in the organization maps contacts from the collaboration 

system to their device in the same way. 

When you tap  in the DME Address Book, or when you tap Edit 

when viewing a contact, DME lets you enter information into the 

following fields. Those marked with * are shown by default. To see 

field which is not shown by default, tap Add field first to add it. 
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Name: 

Prefix 

First * 

Middle 

Last * 

Suffix 

Nickname 

Title 

Department 

Company* 

Phone: 

work* 

home 

other 

work mobile 

other mobile 

work fax 

home fax 

other fax 

assistant 

company 

pager 

E-mail: 

work* 

home 

other 

URL: 

work* 

home 

other 

Address: 

work* 

home 

other 

Street* 1) 

Zip* 1) 

City* 1) 

State* 1) 

Country* 1) 

 

1) For each address type. 

Dates: 

birthday 

anniversary 

Other names: 

spouse 

children 

assistant 

manager 

Notes: 

note 

location 

categories 

IM 1-3 

To delete a contact, swipe the contact left or right in the Contacts 

list, and tap Delete. 
 

Interaction with the device Contacts 

DME contains a complete, built-in contacts application. The primary 

function of the DME Contacts is to keep your business contacts 

synchronized with the contacts on your collaboration system 

(Outlook or Lotus Notes), and keep your business contacts stored 

securely in the DME secure container so that nobody else can gain 

access to them. 

 

DME keeps the data in the DME client (calendar, contacts, etc.) in 

sync with the data on the collaboration system. 
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Your iOS device also includes a contacts application, aptly named 

Contacts. This app is used for keeping personal contacts, and consists 

of either a local source or one or more third-party sources. 

Excitor recommends keeping business contacts in the secure DME 

container, and personal contacts in the device Contacts. This is called 

Secure mode. 

However, if you want to be able to view your business contacts 

without having to log in to DME, you may choose to allow the 

contacts from the DME Contacts to be available from the device 

Contacts application. 

 

This is called Open mode, and can be selected through an option 

called Sync with local in DME. In this mode, your DME contacts are 

copied to a new contacts group named DME in the device Contacts 

app, and are then kept synchronized with DME. This means that if you 

add, delete, or modify a contact in your device Contacts, the change 

will be synchronized to DME, and ultimately to the collaboration 

system (and vice versa). 

The Contacts app can be configured to use third-party sources, such 

as Google GMail or Mobile Me, in the device Settings. If you do this, 

your device Contacts will contain both the DME group of contacts 

and the third-party source: 

 

The different groups of contacts will coexist in the device Contacts 

app, and there is no interaction between them. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

100  © 2013 Excitor 

 

Note: For this to work correctly with third-party synchronization 

services other than iCloud, you must ensure that a local contacts 

source exists before you enable the third-party sync. If it does not 

exist already, the third-party service will take over the entire contacts 

store, and DME will be unable to create a local contacts group. You 

can prevent this from happening in one of the following ways: 

1. Make sure the DME contacts mode is Open (Sync with local is 

On) before you enable third-party synchronization. 

2. Make sure you have at least one contact in your DME contacts (the 

"local source") - even if you have to create one manually. 

3. When you do enable third-party sync, make sure you select the 

option to Keep on my device for the contacts found in the local 

source (you are asked twice). 

Note also that if you choose to synchronize contacts with iCloud, the 

Apple iOS will remove any local contact groups on the device, 

including the DME group of contacts: 

 
So if you want to use iCloud synchronization of contacts with your 

device Contacts, you cannot use the Open contacts mode in DME. 

This is due to a quirk in the Apple iOS: The Apple iOS API does not 

allow local sources (such as DME) when iCloud sync is enabled. This 

has the following consequences: 

 If you are upgrading DME, and you were previously using Open 

mode, and your device Contacts is set up to use iCloud for 

synchronization, DME will cut off the connection between your 

local contacts and the contacts in the secure DME Contacts. No 

contacts will be deleted, but they are no longer managed by DME. 

 If you are using Open mode, and then begin synchronizing 

contacts with iCloud, DME will switch the Copy to Local setting 

off and show the following message, "A 3rd party sync service is 

configured to use the device address book. DME will no longer 

integrate with the device address book." Similar to the scenario 

above, DME then cuts the connection to your local contacts, 

which are then managed by the iCloud service, and not DME. 

For information about how to switch contact modes, see Contacts 

sync. settings on page 132. 
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Adding contacts from Phone app 

If you receive a call from someone, and you want to add the person as 

a contact, you can do so by tapping Create New Contact from the 

Phone application. However, the default iOS behavior is to add the 

contact without any group affiliation - meaning that it will be shown in 

the All Contacts group, but not the DME group. And since the 

contact is not in the DME group, it will not be synchronized with the 

collaboration system. To get around this, and add a contact in the 

DME group, you need to do the following: 

1. Open the Phone app. 

2. Tap Contacts. 

3. Tap Groups (top left). 

4. Tap the DME group. 

5. Tap the + button to create a new contact, fill in the name of the 

contact, and save it. 

6. Tap Recents in the Phone app. 

7. Tap the blue arrow for the phone number that you want to add as 

a contact. 

8. Tap Add to Existing Contact, and choose the contact you 

created in step 5. 

This way you can be certain that the updated contact will be 

synchronized with DME. If you chose Create New Contact in step 

8, the contact would not have been created in the DME group. 

Creating contacts from links in e-mails within DME naturally adds the 

contacts to the DME group of contacts. 
 

Work/home scheme 

Some of the fields in the DME Address Book mentioned above are 

special in that they function as a sort of alias for up to three distinct 

fields. An example of this is the field Mobile. When you enter a 

number into the Mobile field and synchronize, then how can DME 

know if the number should be placed in the Cell phone, Mobile, or 

Mobile 2 in Lotus Notes, or in Business Mobile, Home Mobile, 

or Other Mobile in MS Outlook? 

There is no issue if you enter values in the specific mobile number 

fields: Mobile (home) and Mobile (business). These fields are 

directly supported by the collaboration system. The issue only exists 

if you use the generic Mobile field. 
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When this field (Mobile) is updated on the device, and you choose to 

synchronize contacts, DME considers the following work/home scheme. 

Note that each row in the table below lists all completed fields 

related to mobile phone numbers: 

This field in the DME 

Address Book 

 

maps to 

this field in Notes 

or Outlook 

Mobile ->  Work mobile 

Mobile 

Mobile (business) 

-> Home mobile 

Work mobile 

Mobile 

Mobile (home) 

-> Work mobile 

Home mobile 

Mobile 

Mobile (business) 

Mobile (home) 

-> Other mobile 

Work mobile 

Home mobile 

Note: If you are using Lotus Notes, the last row in the table only 

applies if you are running Domino 8 and above. If you are running 

Domino 7, the value in the Mobile field is stored in a hidden field in 

DME, as Domino 7 and below only supports two mobile numbers. 

DME not only employs the work/home scheme to make a qualified 

guess about where to place the mobile phone number, but from all of 

the following fields, which are of the same type as Mobile: 

E-mail 

Fax 

Mobile 

Tel./Telephone 

Address 
 

To-do 

A to-do item is a special type of calendar item and is synchronized 

with your collaboration system by DME. 
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Tapping the To-do item in the Desktop opens a list of the to-dos 

created on the collaboration system or in DME. You can filter the list 

to show Incomplete to-dos only (standard view), to-dos with high 

Priority only, or All to-dos. 

 
To delete a to-do, swipe left or right across the to-do, and tap 

Delete. 

Tap the  button to perform a manual To-do synchronization. 

For a to-do to be included in the synchronization from the 

collaboration system to the device, the following criteria must be 

fulfilled by the to-do on the collaboration system: 

1. A due date has not been specified, and it has not been marked as 

complete (Domino only). 

2. No start date or end date is specified, and the task is not marked 

as complete. 

3. Or the to-do is overdue and not marked as complete, regardless 

of the values in the starting date and due date fields. 

4. Regardless of the above, a to-do is included if either the starting 

date or the due date is within the time span set in To-do settings 

(the sync window). 

Examples: 

The sync window is set to 10 days in To-do settings, and today is 

April 15th.  

1. A to-do on the collaboration system was created on March 23rd 

with a due date on April 17th. This to-do is synchronized to the 

device because the due date is within the 10-day sync window 

specified in the To-do settings. 

2. Another to-do was created on March 3rd, with a due date of 

March 16th. It has not been marked as completed. This to-do is 

synchronized to the device. When it is marked as completed, it 

will no longer appear on the device. 
 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

104  © 2013 Excitor 

 

Creating and editing to-dos 

 Creating a to-do 

1. Tap  from the Desktop to open the To-do list view. 

2. Tap a task to edit it, or tap  to create a new to-do. 

 

You can now set a due date, an alarm, and a priority for the to-do, 

and you can indicate that the to-do is Private (meaning that other 

people opening your calendar in the collaboration system cannot 

see the to-do in question). These features are similar to the 

corresponding calendar item features. 

3. Set the Completed status. In the To-do list view, you can choose 

to only view incomplete to-dos. 

4. Tap Save to save the to-do in the To-do list. 
 

Notes 

 
If your collaboration system is Lotus Domino, you can synchronize 

notes (formerly called "journals") with your DME client. 

This requires that Notes synchronization is enabled in Settings (see 

Notes sync. settings on page 134). 
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Tap  on the Desktop to open the All Notes screen.  

 
In this screen, you can see all notes that have been synchronized from 

Lotus Notes to the device or created on the device, in all categories. 

You can sort the notes by Subject or by Date. 

To view notes of a specific category only, tap the  icon. 

 

Tap a category, and tap Done. The list is now filtered to show notes 

of that category only. 

Tap a note to edit it, or tap  to create a new note. While creating 

the note, you can choose any category for the note, or you can create 

a new category. You can set a date, and you can add attachments 

from the device to the note. For information about working with 

attachments, see Attachments on page 41 and Sending attachments 

on page 59. 

Tap  to synchronize your notes manually with the collaboration 

system. 
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Feeds 

With a DME 3.6 (or greater) server, you can get RSS feeds on your 

client. The feeds are defined by the DME administrator. 

An RSS feed is a stream of links to articles or other content from a 

website that is frequently updated, such as a news site. Another 

source of an RSS feed could be a sales tools database (a list of new 

orders or other information from the sales database) or many other 

things. 

The advantage of using DME's RSS feed reader over any other feed 

reader is that the content of the feeds, which may be sensitive if the 

feed source is an internal database, is kept within the secure storage 

space of DME. 

To view the feeds that have been set up for you, tap  on the 

Desktop. A screen such as the following is shown: 

 
Each feed to which you subscribe is listed. The number to the right of 

each feed shows the number of unread articles in the feed. You or the 

administrator can limit the number of articles available on the device 

at any one time (see Feed sync. settings on page 135). A standard 

feed called Welcome to DME RSS Feeds is usually included in the 

list; this feed tells you more about the DME RSS Feeds functionality. 

The feeds are updated at regular intervals. The server takes care of 

sending a notification to DME when this happens. To update the feeds 

manually, you can tap the Synchronize icon at the top right of this 

screen. 

To view the articles of a feed, tap the feed title: 
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Unread articles are shown in boldface font. If you tap the top right 

checkmark icon, all articles are marked as read, and you are returned 

to the feed overview screen. 

Tap an article to read it: 

 
Most articles are just an excerpt of a larger article, and include a link 

to the full article. To view the full article in the AppBox secure 

browser (if enabled) or Safari, tap the top right Link icon, and choose 

Open Web address. 

To avoid marking the current article as read, tap the top right Link 

icon, and choose Mark unread. 
 

DME AppBox 

DME AppBox was introduced in the DME client 4.0 for Apple iOS. 

DME AppBox is a secure corporate App Store. With DME AppBox, 

your company can push applications built with HTML5 technology and 

regular websites to the DME client. The users can then open these 

apps and websites securely, knowing that no data can be leaked 

outside the safe DME area on the device. 

When you tap the AppBox icon, DME will connect to the AppBox 

server. 
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When a connection has been established, DME shows the AppBox 

Launchpad. DME comes with a standard Launchpad, but it may be 

customized or completely replaced according to your company's 

needs and design wishes. Therefore the screenshots in this section 

will probably not match what you see on your own screen. 

Furthermore, not everybody in the company gets the same AppBox 

Launchpad. The apps can be configured in many ways. For instance, an 

app can be configured to be shown on tablets only, or it can be 

configured to only be shown to a certain group of users. 

The default AppBox Launchpad might look something like this: 

 
Apps that are designed for offline use are shown first, online apps are 

first shown disabled (grey) and then enabled as they become available. 

If there are more apps than can be shown on one page, you can swipe 

to go to the next page of apps. The number of app pages is indicated 

by a number of dots along the bottom of the page. 

Tap an icon to launch an app. 

All AppBox apps run within the DME secure browser. See the next 

section. 
 

Secure browser 

All DME AppBox apps are launched with the DME secure browser, 

which ensures that no data is able to leak from the browser to the 

client device. Any cookies, cache files etc. are stored and encrypted 

within the secure DME area. 

The secure browser contains no controls (buttons) at all. If the app 

simply shows an ordinary web page, there would be no Back, 

Forward, and Refresh buttons available to the user, and the user 

would be unable to exit the browser and go back to the AppBox 

Launchpad. To provide navigation, the AppBox administrator applies a 

skin to the app. 
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1. The "browser skin" provides standard browser navigation buttons: 

 
1. Back to AppBox Launchpad. 

2. Back (browser Back button). 

3. Forward (browser Forward button). 

4. Progress bar. 

5. Refresh (refresh current page). 

This skin is typically used for intranet sites or other websites that 

have not been made specially for use in DME AppBox. 

2. The "app fullscreen skin" provides a slide-out menu on the left side 

of the screen. It slides out when you tap the three grey vertical 

dots: 

 

This menu may contain one or more of the following functions: A 

spinner is shown during communication with the website. A 

Home button takes you back to the AppBox Launchpad. A Back 

button takes you one step back in the flow of the app you are 

using. 

If the app is designed for DME AppBox, the developer will typically 

place buttons in the top or bottom toolbars to provide the user 

navigation with options to go back to the Launchpad and perform 

other functions, as in the example below: 

 

As described in Links on page 38, the secure browser is also used for 

opening regular web links in e-mails. 
 

Keep documents for offline use 

Sometimes, for example when you read a PDF file online using the 

secure DME browser, you will want to store it for offline use - or just 

to be able to find it quickly again.  
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Whenever you open a PDF or other file from the secure browser, 

DME will display an Offline button. Depending on how the AppBox 

menu item has been configured, this button can either appear at the 

bottom of the slide-out menu: 

 

-or as an overlay button in the lower left corner of the page: 

 

Note that the button is not shown until the entire document has been 

loaded. For large files, this may take a while. 

When you tap the Offline button, you are given the opportunity to 

rename the file. Then tap Save to save the file in the filestore of the 

current app. It can later be found using the DME File Browser. See the 

next section for more information. 
 

File browser 

The DME File Browser app is packaged with DME AppBox. With the 

DME File Browser, you can  

1. Manage all files that are stored in the DME secure 

container by other AppBox apps. 

For example, if you have an AppBox app that gives you access to 

your corporate customer relationship management system, you 

may want to download a contract or a purchase order from a 

certain customer before visiting the customer. The CRM system 

lets you download the requested information as a PDF file to the 

secure DME container, using the Offline button described in the 

previous section. 

To view the PDF file again at a later time, open the DME File 

Browser, and open the CRM system's file store, where the PDF 

file has been saved. 

2. Exchange files with file servers on the internal network. 

Through the File Browser, you get secure access to internal file 

servers. Depending on your permissions on the file server, you 

can view files on the file server, copy them to the Documents 

folder on your device, move and delete files, and create and delete 

folders. 
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File browser setup 

This section requires knowledge of managing the G/On Server. 

To set up the DME File Browser, create a menu action based on the 

DME File Browser template. This template will be included in G/On 

5.6.1 and 5.7.0. Until then, you must download the DME File Browser 

template from the DME Resource Center 

http://resources.excitor.com/dl/support-files#FileBrowserTemplat

e, and add it to your G/On installation before you can create the 

menu action. The template file must be placed in the following 

directory on the G/On Server: 

C:\Program Files 

(x86)\Giritech\gon_5.6.0-19\config\templates 

When the menu action is created correctly, users will have access to 

the DME File Browser. 
 

File browser overview 

The following is a quick overview of the File Browser. On tablets, the 

DME File Browser is divided into two panes: Locations and Files. 

Both panes are visible in Landscape mode; in Portrait mode, you must 

tap Locations to slide out the Locations pane. On regular devices, 

only one pane is visible at a time, and you must tap the Locations 

button to switch between the views. 

The default view is the Recent files location. 

 

1. The Home button closes the File Browser and shows the AppBox 

Launchpad again. 

http://resources.excitor.com/dl/support-files#FileBrowserTemplate
http://resources.excitor.com/dl/support-files#FileBrowserTemplate
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2. The Locations pane is divided into Device locations and 

Remote locations. The Device locations comprise the 

following locations: 

3. The Recent files location shows a list of the most recently 

downloaded files - up to 25 files. The files are listed with the latest 

first, and shows files downloaded from any app. 

4. The Documents location is a place where you can store files 

copied from a remote location or from an application folder. 

5. The Applications location contains a list of all AppBox apps. Tap 

an app to view the files downloaded using that app. For more 

information, see Applications location on page 113. 

6. The Remote locations section of the Locations pane consists 

of the file shares defined on the DME server. Your DME 

Administrator may have defined one or more of such file shares, 

which point to file servers on your local network. Through these 

remote locations, you and you coworkers can exchange files and 

store files that you may need to access when on the road. 

Note that this section is only shown if any remote locations have 

in fact been created. 

7. The file list shows the name of the file, the date of download, and 

the file size. Tap a file to see a preview of it. See Opening a file 

on page 113. 

8. Tap the Edit button, or long-press a file, to perform operations 

on one or more files. See File operations on page 115. 

9. Tap the Refresh button to refresh the file list. 
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Applications location 

The Applications view shows a list of all DME AppBox apps that you 

have access to - all the apps in your AppBox Launchpad. 

 
The column on the right shows the number of files that have been 

downloaded by the app in question. Tap the app in this list to see the 

list of files downloaded by that app. You can now perform various 

operations on those files - see File operations on page 115. 

Tap the + icon at the lower right of the folder list to create a new 

folder inside the current application folder. You can for instance use 

subfolders for archiving purposes. Note that the app will always save 

its files in the top folder in the app's directory. 
 

Opening a file 

To work with a file shown in the DME File Browser, tap the file in any 

location.  
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The file is displayed as a preview. For PDF documents, the first page is 

shown: 

 

1. Tap Close to go back to the previous location view. 

2. Tap Open to open the current file in an external application. The 

choice of application is determined by your operating system. 

Sometimes you are offered a choice between different apps that 

can open the file of the current type. In a later version of the DME 

client for iOS, documents will be opened in DME Editor/Viewer 

(Picsel), if it is available. 

When the file is opened, use the DME AppBox slide-out menu to 

return to the File Browser when you are done reading it: 

 

3. Tap the Delete icon to remove the file completely from the 

location in DME AppBox from which you opened it. 

4. Tap the Rename icon to rename the file, the Copy icon to copy 

the file to another location, or the Move icon to move it. 
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File operations 

In any file list, you can tap the Edit button to perform various 

operations on one or more files in the list. Alternatively, you can 

long-press a file or folder to enable the Edit mode. 

 

1. Tap to select one or more files or folders in the list. 

2. Tap Cancel to exit the Edit mode. Tapping another location also 

exits Edit mode. 

3. In the footer bar, you can choose among the following functions: 

1. Delete: Delete the selected files and folders. 

2. Rename: Rename the selected file or folder. You can only do 

this for one file or folder at a time. 

3. Copy: Select one or more files and folders, and tap the Copy 

icon. Then browse to another folder, and tap the Copy here 

button. You can repeat this, or tap Cancel to exit the copy 

operation. Please note: You cannot copy folders from one 

remote location to another remote location. 

4. Move: Select one or more files and folders, and tap the Move 

icon. Then browse to the folder of another app, and tap the 

Move here button. You can repeat this, or tap Cancel to exit 

the move operation. Please note: You cannot move folders 

from one remote location to another remote location. 

5. Select all/Unselect all: Tap the Select all button to select 

all the files in the currently shown list. Tap it again to unselect 

all files. 
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Attachments 

From the Desktop, you can open the Attachments view, which lists 

all attachments included in any e-mails, meetings, to-dos etc. currently 

on the device (in all folders). The lists shows if the attachment has 

been downloaded to the device or not: if the top left corner of the 

file icon is colored dark, it means that the attachment is only located 

on the mail system server; if the corner is not colored dark, the 

attachment has already been downloaded to the device, encrypted, 

and stored in the secure DME area. 

 
For each attachment, the list shows the filename of the attachment 

and the subject and date of the item (e-mail, meeting invitation, etc.) 

in which the attachment is included. The icon shows the file type of 

the attachment in question (most file types can be recognized, but not 

all). All this information is searchable - you can filter the list of 

attachments by typing in the Search box above the list. 

The file size is also shown is your collaboration system is set up 

correctly. If you are using Domino or Exchange 2003, the file size is 

always available, but Exchange 2007/2010 has some issues in this area. 

The file size is always shown if the attachment has been downloaded. 

The slider along the bottom of the view lets you quickly filter the 

attachments based on their size - if you move the slider toward the 

right, the smallest attachments are filtered out of the list. This 

requires that the file sizes are known (see above). 

You can also sort the attachments by name, size, and date (default) by 

tapping the Sort button. 
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Tap an attachment once to download the attachment to the device, 

or (if already downloaded) tap once to view the attachment in the 

associated viewer. For each attachment listed, a blue arrow provides a 

link to the e-mail, meeting, or to-do in which the attachment is 

included. Tap the blue arrow to open the item in question. 

Finally, you can tap the Download All button to retrieve all 

attachments from the server. This is for instance useful if you want to 

make sure that all your attachments are available during an overseas 

flight. 

The Attachments view was introduced in DME for iOS 3.6.2. 

See also Tools on page 117 for information about deleting 

attachments from the device. 
 

Tools 

Tap  from the Desktop toolbar to access options that apply to 

DME in general. The options include the following items: 

 Settings: Control the look and feel and the operation of your 

DME client. See Settings on page 126. 

 Reset...: Refresh the contents of your DME client with a new 

copy from the server. Care should be taken before importing 

contacts and calendar items. See Initial import and reset on page 

16. 

 Change password: With this function, you can change your 

network password. See Changing mailbox passwords on page 

10. 

 Set swipe code: With this function, you can temporarily replace 

your collaboration system password by a simpler swipe code for 

use on the DME client. See Logging in on page 21 and the next 

section, and Setting an unlock pattern on page 119. 

 Log: Displays the event log, which is kept by the DME client. The 

log can be useful in case of support questions, and you can send it 

as an e-mail by tapping the  icon in the Log view. You can also 

choose to delete the log by tapping the  icon. See Further 

assistance on page 135. 

 Delete all attachments: When you download attachments to 

the device, the attachments will take up space. To free this space, 

you have the option to remove downloaded files from the device. 

The attachments will not be deleted on the mail system, only on 

the DME client. This action removes all attachments that have 

been downloaded to the device. Please note that this option is 
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only shown if any attachments have in fact been downloaded to 

the device. 

 Remove client cert.: If your DME system uses the "client 

signing" feature for added security, the DME administrator will 

issue a client certificate which is valid for your device only. This 

means that the device is only given access to the DME system if 

this certificate is installed on the device. If the administrator needs 

to issue a new certificate to the device for some reason (for 

instance if the device is given to another user), then you need to 

log in to DME (as the previous user), and tap Tools > Remove 

client cert. before the new user is able to connect to the DME 

system. The DME server will transfer the new certificate on first 

connect, and the DME client will install it. 

If you are unable to log in as the previous user, and the device is 

unable to connect to DME due to a client signing error, you can 

enter FLUSHKEYS as user name at the Login screen, and tap Login. 

This will clear the old client certificate from the device. When you 

log in again, you will be able to connect to the DME system and 

receive the new client certificate. 

NOTE: You should only remove the client certificate (using this 

function or the FLUSHKEYS keyword) if instructed to do so by the DME 

administrator, as the administrator needs to issue a new key to 

your device when the old client certificate has been removed. 

Please note that the Remove client cert. option is only shown if 

the server has sent a certificate to the device. 

 Lock: If your device is an iPhone 3GS, iPhone 4, or iPad, and you 

run iOS 4+, you can choose whether pressing the Home button 

should lock DME (log you out of DME) or hide (minimize) DME 

without logging you out. If you have chosen Hide, you can still log 

out of DME manually by tapping this option. See General settings 

on page 126. 

 Out of office: With this function, you can enable, disable, and 

modify your Out-of-Office text. See Out of office on page 120. 

 MDM Enrollment: With this function, you can initiate an Apple 

MDM Enrollment of your device with the DME Server from the 

client. See MDM Enrollment on page 122. 

 About DME: Shows the DME splash screen with the DME logo 

and information about the version of the DME client you are 

running. 
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Setting an unlock pattern 

For reasons of security, you may be required to enter a long, complex 

password with a mix of letters and special symbols to gain access to 

the network and collaboration system. This may be easy enough to 

enter on a full PC keyboard, but you might find it difficult to enter 

using your phone keypad. 

Instead of using your collaboration system password for logging in, it 

is possible to substitute the password for an unlock pattern 

(previously known as a swipe code). An unlock pattern is defined by 

moving your finger across the screen. 

The DME administrator can set a minimum number of tiles you must 

cover when entering the pattern. See details below. 

In order to maintain high security on the device, the following special 

conditions apply when using the unlock pattern instead of the regular 

password: 

 The pattern defined by you may expire after some time. The 

validity period of the pattern is set by the DME administrator, and 

could for instance be 8 hours, corresponding to one working day. 

The validity period begins when you log in to DME using your 

regular password. After this, you can swipe to log in to DME, until 

the validity period runs out. Then you have to use your regular 

password again in order to reset the validity period. You do not 

have to change the unlock pattern. 

The administrator may choose to allow an unlock pattern that 

never expires, but this is not recommended. 

 If you attempt to log in using swipe, but you enter the pattern 

wrong twice, then you have to use your regular password for your 

next attempt. Your unlock pattern is not invalidated, however - 

you can use it the next time you log in to DME. 

Note that the feature may be disabled entirely by the DME 

administrator for security reasons. 

Note on security 

Using a regular password offers the best protection of your data. If 

you use the regular password method for logging in, the network 

password is only kept in memory, and not stored when DME shuts 

down. Using the swipe feature, your encrypted password will 

remain in the device storage, even when DME is shut down. As the 

key protecting the encryption of the password can be derived from 

a relatively small number of combinations when using the unlock 

pattern feature, the security level must be regarded as medium 

when enabling the unlock pattern feature. 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

120  © 2013 Excitor 

 

 Substituting password for unlock pattern 

1. Log in to the DME client using your regular collaboration system 

password. 

2. In the Desktop toolbar, tap  > Set unlock pattern. 

If you cannot find this option, it is because the DME administrator 

has disabled it. 

3. The following screen consisting of 12 circular tiles is shown: 

 
4. Now move your finger vertically, horizontally, and diagonally 

across any of the 12 tiles in the screen. For the pattern to become 

a valid swipe code, you must cover at least the number of tiles 

that are defined as the PIN code/swipe minimum length by 

the DME administrator. 

Note that it is possible to swipe back across tiles you have already 

"used". 

5. Repeat the swipe to confirm the new unlock pattern. 

If you accidentally move your finger across tiles that you did not 

intend to touch, you can undo the current swipe by tapping 

another tile with another finger while not releasing the first finger 

from the screen. The screen will flash, indicating that your swipe 

attempt was canceled, and you can try again. 

The unlock pattern definition screen closes, and your new pattern is 

set. 
 

Out of office 
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With DME, you can create, edit, enable, and disable your 

Out-of-Office (OOF: Out-of-Office Functionality) message. Please note 

that it is only possible to do this if you are using Microsoft Exchange.   

When you synchronize, the information added here will update the 

Microsoft Outlook rule in the collaboration system. This way, you can 

for instance enable your OOF agent from your phone, if you forgot to 

do so during the last hectic hours at the office before your vacation. 

To configure your OOF rule, select Tools > Out of office. DME 

connects to the server to read the current OOF settings from 

Exchange. 

 

 Enabled 

Select this field to enable the Out-of-Office rule; deselect the field 

to disable the rule. 

 Start 

In this field you can choose a date and time at which the OOF rule 

should become active, if enabled. 

 End 

In this field you can choose a date and time at which the OOF rule 

should become inactive again. 

 Description 

In this field you can enter or edit the text which will be used in 

the automatic response to people who write to you while the 

OOF rule is enabled. 

When you are done, select Change or Update (depending on 

device) to synchronize the rule with Exchange. There are a few things 

you should be aware of in the way the OOF information is handled by 

different versions of Exchange: 

 
Exchange 2003: Exchange 2003 does not support start and end days 

for OOF rules, and the dates will be ignored by Exchange 2003. 

Exchange 2007/2010: DME does not support different reply 

messages for internal and external recipients. The text from the 

Description field will be used for both types of recipients. 
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MDM Enrollment 

With the MDM Enrollment option in the Tools menu, you can 

initiate an Apple MDM Enrollment of your device with the DME 

Server from the client. MDM gives the DME Administrator the ability 

to securely configure and update settings, monitor compliance with 

corporate policies, and remotely wipe or lock your device in case it is 

lost or stolen. 

Please note that the MDM Enrollment option will disappear from 

the menu after you have selected it. So when you select the option, 

you should complete the enrollment process. If the MDM enrollment 

process is interrupted along the way, for instance due to the Internet 

connection being lost, please contact your DME Administrator for 

information about how you can repeat the enrollment process. 

When you select this option, the DME client will first ask you if you 

are sure you want to enroll the device: 

 

If you tap Yes, the DME client will check the Wi-Fi address (also 

known as the MAC address) of your device. The Wi-Fi address is 

used as a unique identifier for your MDM-enrolled device on the DME 

server.  

If your device was running iOS7 when you upgraded to DME 4.1.4 (or 

later), the DME client will not be able to find the address. In this case, 

you will need to enter the Wi-Fi address yourself. To do so, please 

follow the guidelines for copying and pasting the Wi-Fi address in the 

section DME and iOS7 on page 24. 

When the Wi-Fi address has been obtained, the client will perform a 

full system info sync with the server, and then open Safari at the 

address <SERVERPATH>/mdm (where <SERVERPATH> is the path to the 

DME server, including port). If the DME server has been set up 

correctly, this link enables the user to complete the enrollment 

procedure: 
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1. Log in to DME. Use the same login credentials as you use for the 

DME client. 

 

2. Then complete the steps in the following section - see Installing 

Apple MDM profile on page 123. 
 

Installing Apple MDM profile 

When the user has been directed to the DME Apple MDM 

Enrollment web page, he or she is presented with the following page 

containing instructions and two links: 

 
1. The user should first tap link no. 1 to install the DME Apple MDM 

root certificate on the device. This root certificate is self-signed 

and auto-generated by DME for the purpose of signing any profiles 

distributed by DME, including the main MDM profile. If the user 

omits this step, all profiles distributed by DME will be Unsigned 

(but still valid). 

After tapping the link, the user should tap the Install button and 

complete the installation. 
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2. To complete the enrollment, the user must now go back to the 

DME Apple MDM Enrollment web page and tap link no. 2 to 

install the DME Mobile Device Management profile. This will 

initiate a SCEP communication session, through which the device 

receives a certificate generated by the DME Apple MDM server. 

This certificate establishes the trust between server and device, 

enabling the silent installation of configuration and provisioning 

profiles and the execution of MDM actions. 

After tapping the link, the user should complete the installation 

process. 

Please note: On some devices, the certificate appears to be Not 

trusted and Unsigned. This is due to a quirk in iOS and has no 

practical importance for the security of DME. 
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When tapping Install, the DME MDM server and the device will 

communicate using SCEP. It will proceed through the following 

actions: 

  

 
Finally, the following screen is shown to indicate that the 

installation is complete. 

 

Tap Done. Profiles can be inspected in Settings > General > 

Profiles on the device. 
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Settings 

When a new device is created in DME, a set of default settings for the 

device is sent to the client the first time the device connects with the 

server, or when a new user takes over an existing device. These 

settings should represent your company's security policy.  

Note that the DME administrator may have blocked your access to 

changing any or all of the settings described in the following sections. 

When a "permitted range" is mentioned in the following sections, the 

range may in fact have been changed by the DME administrator. 

The "Deployment guide" contains information for DME administrators 

about recommended settings and permitted range values. 
 

General settings 

 Phone number 

Tap to enter the phone number of the device. The DME server 

needs to know your phone number for sending SMS messages to 

the device, and for device management purposes. This field is only 

available if your device has a phone module (that is, not iPod touch 

and iPad WiFi). 

 Server path 

This is the path (host name, port number, and SSL option) to the 

DME server. You set this value once, the first time you start DME. 

The server path should rarely be changed, and only if your DME 

Administrator tells you to. A Test connection button lets you 

verify if you entered the information correctly. For more 

information, see First-time login on page 22. 

 AppBox server path 

This setting will usually be locked on the server, and invisible on 

the client. The field contains a connection string used to be able to 

connect to the G/On AppBox server. The AppBox server is 

required in order for Web AppBox and the DME secure browser 

to work on the device. This connection string is automatically 

entered after your first system information sync. 

The connection string should not be changed unless you are 

specifically asked to do so by the DME system administrator. 

 Language 

Tap to select the language of the DME interface. The language 

change takes effect immediately. The client currently supports the 

following languages: 
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Chinese (simplified), Danish, Dutch, English, French, German, 

Japanese, Korean, Norwegian, Russian, Spanish, Swedish. 

 Home button 

If your device supports multitasking (iPhone 3GS and above, iPad, 

or iPod 3rd generation and above running iOS 4 or later), you can 

choose how pressing the Home button should affect DME. 

 Lock: Pressing the Home button locks DME - meaning that 

you are logged out of DME. When you later tap the DME icon 

again, you are required to log in. 

 Hide: Pressing the Home button hides (minimizes) DME, 

without logging you out. When you later tap the DME icon 

again, you are not required to log in (unless the amount of 

time set as Logout timeout has passed in the meantime), but 

you are immediately returned to the screen from which you 

pressed the Home button. In order to log out, you must go to 

the DME Desktop and tap Tools > Lock. 
 

Security settings 

 Logout timeout (min) 

The DME client is locked automatically after the specified number 

of minutes of inactivity. The value 0 means never logout 

automatically (not recommended). Permitted range: 0-600 

minutes. 

 Private key password 

In this field you can specify your password for your private key. 

Your private key is used for decrypting encrypted messages sent 

to you, and for signing private messages. If you do not enter a 

password here, you cannot read encrypted messages or sign new 

messages from your mobile device. 

If your collaboration system is using Notes Encryption, you 

must enter the password for your user ID file. 

If your collaboration system is using S/MIME, enter the password 

for your private key in this field. You must also upload your 

personal certificate to the DME server (using myDME).  

For more information about Notes Encryption, S/MIME, and 

myDME, please contact your DME administrator. 
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E-mail sync. settings 

 E-mail sync. 

If you enable this setting, e-mail synchronization is enabled. This 

setting affects both manual and push synchronization. 

If you disable this, e-mails are never synchronized. 

 Days back 

When e-mails are synchronized, e-mails from the last number of 

days selected here will be synchronized and available in the Inbox. 

Permitted range: 0-99 days. 

 Send immediately 

If you select No, e-mails are stored in the Outbox folder when 

you select Send, and are not sent until the next scheduled or 

manual synchronization. 

If you select Send only, e-mails created on the device are sent 

immediately when you select Send from a new e-mail or meeting 

invitation, but any new items are not retrieved from the server. 

This significantly reduces the load on the server and the time it 

takes to synchronize. 

If you select Send & Receive, e-mails created on the device are 

sent immediately when you select Send from a new e-mail or 

meeting invitation - that is, a regular e-mail synchronization is 

performed. 

 Sort order 

Tap this option to set the order in which e-mails in your e-mail 

folders should be sorted. For more information, see Sorting 

e-mails on page 65. 

 Mark as read when shown in preview pane 

This setting applies to iPad only. If you set this to On, an e-mail 

will be marked as read when it has been shown in the Preview 

pane on your iPad. 

 Mail alert 

Tap this option to select which sound (or no sound) you want 

hear when you receive a new mail in DME. 
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 Start 

In this field you can specify the time of day after which you want 

to start receiving audible e-mail notifications, if this is enabled. 

Spin the time selection wheels to select a time. 

 

 End 

In this field you can specify the time of day at which you no longer 

want to receive audible e-mail notifications, if this is enabled. 

 Vibrating alert 

If you enable this function, the device vibrator will buzz when you 

receive an e-mail in DME. 

 Signature 

Any text you enter in this field will be appended to all new e-mails 

sent from the DME client. You typically use it for adding a 

signature. Note that the DME administrator can add another text 

to be appended to e-mails, called an "E-mail disclaimer". DME will 

add the signature from this field first, and then the e-mail 

disclaimer will be added by the DME server at the very end of the 

e-mail (after any reply history). 
 

Folder sync. settings 

 Sync. contents 

In this field you can specify you can choose to enable 

synchronization of e-mails in subfolders by default. The e-mails are 

synchronized for the number of days specified in the Days back 

field. You can change the setting for individual e-mail folders (see 

Setting folder options on page 32). 

Regardless of this setting, the folder structure as such (without 

e-mails) is synchronized between the collaboration system and the 

device. You need the folder structure when choosing where to 

search for e-mails on the server - see E-mails (on server) and for 

moving e-mails to other folders. 
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 Days back 

In this field you can specify how many days back the DME client 

should synchronize e-mails in subfolders. Note that with higher 

numbers, the load on the DME server will increase. This number 

may be changed for individual folders. 

 Apply to all folders now 

This option will always be off when you open the folder settings 

screen. Think of this option as an action button - if you tap it, the 

settings for Days back and Sync. contents made in this screen 

will be applied to all folders instantly, regardless of their individual 

settings. This is a way to apply the default settings selected here to 

all folders at the same time. 
 

Calendar sync. settings 

 Calendar sync. 

If you select Enabled, calendar synchronization is enabled. This 

setting affects both manual and push synchronization. 

If you select Disabled, calendar items are never synchronized. 

 Days back 

Items from the last number of days selected here will be 

synchronized and be available on the device. To select the number 

of days, spin the wheels. If you select Months in the right-hand 

wheel, the Days counter is increased by a factor of 30. If you 

select Years, the Days counter is increased by a factor of 365. 
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 Days forward 

When items are synchronized, items up until the number of days 

selected here will be synchronized and available in the Calendar. 

 Alarm sound 

If you enable this setting, DME will play the calendar alarm 

specified in the Sound field below when displaying a calendar 

alert. 

 Sound 

If the field Alarm sound above is ON, you can choose which 

sound to play when a calendar alarm goes off. You can choose 

between Reminder and the standard Apple OS Alert. 

 Device Calendar 

 
With this setting, you can change the security level of the DME 

Calendar's interaction with the native calendar on your device 

(requires at least DME Server 3.5). 

 Copy to local - On: This is also called Open mode. DME 

creates a calendar called DME in the local source of the device 

calendar, and shows calendar entries from DME in that local 

calendar. The entries from DME are copied (one-way sync.) to 

the device calendar, and you can then view your calendar 

entries without having to log in to DME. 

When you use this mode, appointments in the local DME 

calendar in the device Calendar app must be 

created/updated/deleted from within the secure DME calendar 

in order for the changes to be reflected in the collaboration 

system. 

DME shows a message telling you what is about to happen 

when you use this mode, stating the number of calendar 

entries that will be copied to your local calendar. Tap Copy to 

start the copying process, or Cancel to cancel. 

Please note: Open mode is not supported on iOS4 devices. 

Note also that if iCloud calendar synchronization is enabled in 

your device calendar, your DME appointments will not be 

visible in the device calendar. This is because Apple iOS hides 

all local calendars when you enable iCloud calendar 

synchronization for some reason. 
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 Copy to local - Off: This is also called Secure mode. There 

is no interaction between DME and the device calendar - your 

business appointments are kept secured by DME. When you 

switch to Secure mode, the local DME calendar is removed. 

When you change this setting to On, a message explaining what is 

going to happen will be shown. When you switch to Off, the 

change takes effect immediately. 

 Show in DME - On: Events from the device calendar will be 

shown in the DME calendar also, in the colors defined for the 

device calendars in the device Calendar app to set them apart 

from regular DME events from the collaboration system. You 

can even tap them and edit them from within the DME 

calendar, but when you do so, you are actually using the 

underlying Apple Calendar, not DME. 

See Interaction with the device Calendar on page 74 for 

important information about and a more in-depth explanation of the 

implications of Open and Secure mode. 
 

Contacts sync. settings 

 Contacts sync. 

If you select On, contact synchronization is enabled, and your list 

of contacts on the device will be kept in sync with your personal 

address book on the collaboration system. 

If you select Off, contacts are never synchronized. 

 Device Address Book 

With the setting in this field you can choose how DME should 

interact with the native address book on your device - the 

Contacts application. As of version 3.5.4 of the client, DME 

contains an internal address book - the DME Contacts. You can 

choose to keep your business contacts in the DME Contacts and 

your private contacts in the native Contacts application - for 

reasons of security, work/life balance, or both. This is determined 

with the following setting: 

 

 Sync with local - On: This is also called Open mode. 

Contacts from DME are shown in a separate group called 

DME in the device Contacts application. Contacts in this 

group are kept synchronized with the DME Contacts insofar as 

the native contacts application supports the DME address book 

fields. 
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When you select this option, DME shows a message describing 

how many contacts will be copied from the secure DME 

contacts to the device contacts. Furthermore, you are 

prompted to decide what you want to do with any contacts 

that already exist in your device Contacts: Merge, Delete, or 

Ignore.  

 
Merge: DME will import the contacts in the device address 

book and merge them with the DME contacts in the DME 

group of the device contacts. This might create duplicate 

entries. Use this option if you have previously had DME 

manage your device contacts, or if you would like DME to do 

so from now on. 

Delete: DME will delete the contacts in the device address 

book. Use this option to clean up old contacts from your 

device address book before exporting DME contacts to it. 

Ignore: DME will ignore the contacts in the device address 

book, and simply create a new DME group. The contacts will 

co-exist. Use this option if you wish to keep your private 

contacts, but also have your DME contacts in the device 

address book. 

Tap the info icon to view the above information about each 

option. 

Tap one of the three options, and tap Synchronize to carry 

out the switch to Open mode. 

Note that if you synchronize your device address book using 

iCloud, the Sync with Local option can only be Off. This is 

because the Apple iOS does not permit DME to create a local 

group in the device address book when iCloud is enabled. We 

hope that this will change in the future. 

When you use this mode, you can access your business 

contacts without having to log in to DME. Or, to put it in 

another way, your contacts are no longer secured by DME. 
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 Sync with local - Off: This is also called Secure mode. 

There is no interaction - contacts in the DME Contacts and in 

the device Address Book are kept completely separate. This 

lets you keep your business contacts in sync with your 

collaboration system securely in DME. Note that when you 

select this option, DME will delete any contacts in the DME 

group of the Contacts application immediately. 

See Interaction with the device Contacts on page 98 for more 

information. 
 

To-do sync. settings 

 To-do sync. 

If you select On, to-do item synchronization is enabled. 

If you select Off, to-dos are never synchronized. 

 Days back 

When to-dos are synchronized, items from the selected number 

of days back in time will be synchronized and available in the 

device. See To-do on page 102 for more information. 

 Days forward 

When to-dos are synchronized, items with a date up until the 

selected number of days ahead in time will be synchronized and 

available in the device. 
 

Notes sync. settings 

 Notes sync. 

If your collaboration system is Lotus Domino, you are able to 

synchronize notes (journals) from your Lotus Notes when you 

enable this option. 

If you disable this option, notes are never synchronized. 

 Days back 

When notes are synchronized, items from the selected number of 

days back in time will be synchronized and available in the device. 

See Notes on page 104 for more information. 

 Days forward 

When notes are synchronized, items with a date up until the 

selected number of days ahead in time will be synchronized and 

available in the device. 
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Feed sync. settings 

 Feed sync. 

Feed sync. must be enabled if you want to use the built-in DME 

newsfeed reader. For more information, see Feeds on page 106. 

 Max. articles in feed 

This setting determines how many articles DME is permitted to 

download per feed. Options are Unlimited, 50, or 100. 
 

Further assistance 

If you have read this guide and still have questions concerning the 

function and use of the DME client, please contact your Helpdesk 

(usually the internal IT department). 

Before contacting your DME administrator, be sure to have 

information about your DME version etc. ready. 

 Supplying support information 

To find the version number of your DME client: 

1. From the DME Desktop, tap Tools > About DME. 

 
DME keeps a log of the events that take place in the client. Your 

Helpdesk may ask for this. Do the following: 



DME Client User Guide 4.1.5 

User guide: DME on Apple iOS devices 

 

136  © 2013 Excitor 

 

1. From the DME Desktop, tap Tools > Log. 

 

2. Tap Export log  to add the log text as an attachment to a 

new e-mail. 

3. Send the log to Helpdesk. 

Note that the DME administrator may also retrieve the log from the 

DME Server interface. 
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List of procedures 

 Logging in to DME for the first time 23 

 Uninstalling the DME client for iOS 26 

 Opening an attachment 41 

 Editing and printing attachments 44 

 Removing all attachments from the device 45 

 Moving an e-mail 46 

 Deleting an e-mail 46 

 Viewing e-mail details 46 

 Toggling flag for an e-mail 47 

 Creating and sending an e-mail 47 

 Editing or removing recipients 50 

 Setting message options 51 

 Saving an e-mail as a draft 51 

 Replying to an e-mail 52 

 Forwarding an e-mail 52 

 Converting e-mail to meeting 53 

 Creating new documents 56 

 Editing documents 58 

 Sending attachments in original e-mails and replies 59 

 Sending attachments in e-mails you are responding to 61 

 Adding attachments to meeting invitations 62 

 Adding attachments to notes/journals 62 

 Deleting an e-mail from the mailbox view 63 

 Deleting multiple e-mails 64 

 Moving multiple e-mails 64 

 Marking multiple e-mails read or unread 65 

 Sorting e-mails 65 

 Toggling flag for multiple e-mails 66 

 iCloud: Setting up DME Open mode with iCloud 76 

 iCloud: Fixing duplicate iCloud calendar entries 77 

 iCloud: Disabling and re-enabling iCloud 78 

 Calendar options for the meeting chair (organizer) 82 

 Calendar options for meeting participants 83 
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 Responding to a meeting invitation 84 

 Creating a new meeting 88 

 Downloading rooms and resources 92 

 Selecting rooms and resources 92 

 Checking free time 93 

 Creating a to-do 104 

 Substituting password for unlock pattern 120 

 Supplying support information 135 

 



 

 

 


